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Introduction

Welcome to the Autodesk Inventor 2009: Advanced Assembly and Machine Design Autodesk Official 
Training Courseware (AOTC), training courseware for use in Authorized Training Center (ATC®) 
locations, corporate training settings, and other classroom settings.

Although this courseware is designed for instructor-led courses, you can also use it for self-paced 
learning. The courseware encourages self-learning through the use of the Autodesk® Inventor®
2009 Help system.

This introduction covers the following topics:

■ Course objectives
■ Prerequisites
■ Using this courseware
■ Completing the exercises
■ CD contents
■ Installing the exercise data files from the CD
■ Projects
■ Notes, tips, and warnings
■ Feedback

This courseware is complementary to the software documentation. For detailed explanations of 
features and functionality, refer to the Help system in the software.

Course Objectives

After completing this course, you will be able to:

■ Create designs that are derived from other designs or utilize skeletal models, add and modify 
tolerances to your model dimensions, monitor design aspects through the use of AutoLimits, and 
manage the amount of assembly data that gets loaded into memory.

■ Create and modify adaptive sketches, features, parts, and subassemblies and also set and use 
flexible subassemblies.

■ Configure Content Center libraries and publish, manage, and use Content Center data.
■ Use Design Accelerator tools to conduct complex calculations and generate mechanical geometry 

based on the functional requirements of a design.
■ Create and modify frame assemblies using the Frame Generator, and create and publish custom 

profiles for use in the Frame Generator.
■ Create detailed weldment assemblies and create corresponding documentation in the form of 

drawings and reports.
■ Create, use, and document product families using iAssembly configurations.
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Prerequisites

This course is designed for experienced Autodesk Inventor users who want to learn more about the 
advanced assembly and machine design tools and workflows in Autodesk Inventor 2009. 

It is recommended that you have:

■ Completed the Autodesk Inventor 2009: Essentials courseware or have a working knowledge of 
parametric part and assembly design and documentation using Autodesk Inventor 2009.

■ A working knowledge of Microsoft® Windows® 2000 or Microsoft® Windows® XP.

Using This Courseware

The lessons are independent of each other. However, it is recommended that you complete these 
lessons in the order that they are presented unless you are familiar with the concepts and functionality 
described in those lessons.

Each chapter contains:

■ Lessons
Usually two or more lessons in each chapter.

■ Exercises
Practical, real-world examples for you to practice using the functionality you have just learned. 
Each exercise contains step-by-step procedures and graphics to help you complete the exercise 
successfully.

Completing the Exercises

You can complete the exercise in two ways: using the book or on screen.

■ Using the book
Follow the step-by-step exercises in the book.

■ On screen
Click the AOTC - Inventor 2009 Advanced Assembly and Machine Design icon on your desktop, 
installed from the CD, and follow the step-by-step exercises on screen. The onscreen exercises are 
the same as those in the book. The onscreen version has the advantage that you can concentrate 
on the screen without having to glance down at your book.
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After launching the onscreen exercises, you might need to alter the size of your application window 
to align both windows.

CD Contents

The CD attached to the back cover of this book contains all the data and drawings you need to 
complete the exercises in this course.

Installing the Exercise Data Files from the CD

To install the data files for the exercises:

Unless you specify a different folder, the exercise files are installed in the following folder: 

C:\Documents and Settings\All Users\Autodesk Learning\Inventor 2009\
Advanced Assembly and Machine Design

After you install the data from the CD, this folder contains all the files necessary to complete each 
exercise in this course. You can also use the Autodesk Learning shortcut on your desktop to quickly 
access the datasets for each AOTC course on your system.

Projects

Most engineers work on several projects at a time, and each project might consist of a number of files. 
You can use Autodesk Inventor projects to organize related files and maintain links between files. This 
courseware has a project file that stores the paths to all the files related to the exercises. When you 
open a file, Autodesk Inventor uses the paths in the current project file to locate other required files. 
To work on a different project, you make a new project active in the Project Editor. 

1. Insert the courseware CD.

2. When the setup wizard begins, follow the instructions onscreen to install the data.

3. If the wizard does not start automatically, browse to the root directory of the CD and 
double-click Setup.exe.
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Follow the instructions below to locate the Advanced Assembly and Machine Design project file for this 
courseware and make it active.

Notes, Tips, and Warnings

Throughout this courseware, notes, tips, and warnings are called out for special attention.

Feedback

We always welcome feedback on Autodesk Official Training Courseware. After completing this course, 
if you have suggestions for improvements or if you want to report an error in the book or on the CD, 
please send your comments to AOTC.feedback@autodesk.com.

1. Start Autodesk Inventor.

2. If the Autodesk Inventor New or Open dialog box does not appear, click File menu > Projects. 

  

3. At the bottom of the Projects dialog box, click Browse.

■ Browse to C:\Documents and Settings\All Users\Autodesk Learning\Inventor 2009\
Advanced Assembly and Machine Design.

■ Click Advanced Assembly and Machine Design.ipj.
■ Click Open.
■ Click Done.

Notes contain guidelines, constraints, and other explanatory information.

Tips provide information to enhance your productivity.

Warnings provide information about actions that might result in the loss of data, 
system failures, or other serious consequences.
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Chapter

4

Design AcceleratorsChapter 4: 

In this chapter, you learn how to design with efficiency and confidence by focusing on the 
functional requirements and specifications of your design. You can achieve design efficiency by 
creating parts and assemblies based on their function rather than their geometric descriptions. 
You design with confidence as you achieve engineering calculation results based on real-world 
attributes such as speed, power, material properties, and your other design specifications.

You accomplish both efficiency and confidence by learning how to use Design Accelerator tools 
to conduct complex calculations and generate mechanical geometry based on the functional 
requirements of a design.

Objectives

After completing this chapter, you will be able to:

■ Describe the contents, purpose, and benefits of Design Accelerator.
■ Use the Bolted Connection Component Generator to create and edit bolted connections in 

your assemblies.
■ Use the Shaft Component Generator to design and edit shafts in your assemblies.
■ Create and edit bearings using the bearings generator in Design Accelerator.
■ Create and edit spur, bevel, and worm gears using the gear generators offered in 

Design Accelerator.
■ Create and edit belt drive systems using the belt generator in Design Accelerator. 
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Lesson:  Introduction to Design Accelerator

Overview

This lesson describes the characteristics, purpose, and benefits of Design Accelerator.

When you design an assembly for a machine, you generally need to bolt pieces together, transfer 
energy and motion through belts, chains, or gears, or add shafts and bearings to the design. You may 
also need to conduct different calculations such as determining the strength of joints that are 
soldered, welded, or bolted together with hubs. With Design Accelerator, you can focus on the 
functional requirements of your machine design because you can create these types of parts and 
conduct these calculations easily and efficiently.

In the following illustration, along with the parts that were manually designed and modeled, this basic 
gear box also consists of shafts, key ways, gears, bearings, nuts, bolts, and washers that are all based 
on engineering principles and industry standards. 

Objectives

After completing this lesson, you will be able to:

■ Explain the characteristics and functionality of Design Accelerator.
■ Describe the benefits and capabilities of component generators. 
■ Describe the benefits and capabilities of mechanical calculators. 
■ Explain the purpose of the Engineer’s Handbook. 
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About Design Accelerator

Design Accelerator can enhance your productivity as you create machine designs. By learning about 
the characteristics and functionality of the Design Accelerator, you identify tools and resources that 
make your design work more efficient. 

In the following illustration, a dual strand chain design was created to transfer power and motion from 
the electric motor to a blower unit. The chain design consists of a roller chain, sprockets, and a flat 
idler. All the components of this chain design were generated using a single Design Accelerator tool 
and calculated to ensure that the chain meets the design requirements. 

Definition of Design Accelerator

Design Accelerator is a collection of tools and resources that enables you to efficiently create and 
validate your designs within a saved assembly file. The tools and resources are divided into three 
groups:

■ Component generators
■ Mechanical calculators
■ Engineer’s Handbook

Using component generator tools, you can create mechanically correct components automatically 
based on the values that you enter. Component generators not only create new geometry, some 
generators also insert components directly from the Content Center. For those Content Center 
components to be inserted into your assembly, you must be logged into the ADM Server.

With mechanical calculators, you can conduct different engineering calculations to help ensure that 
your design meets specific quality and other requirements.
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To facilitate use of the generators and calculators, the corresponding formulas and supporting 
information are included in the Engineer’s Handbook. You can access this information for details 
about the formulas being used, or to ensure that the methods of calculation match your design use 
and requirements.

The generators and calculators are supported by common engineering knowledge and formulas. 
When you are entering data into the edit fields for a component generator or mechanical calculator, 
you can also enter units with the values and enter a value as a formula.

Access

To create new assembly content using a component generator, conduct a mechanical calculation, or 
review information in the Engineer’s Handbook, you access tools from the Design Accelerator panel 
bar when working in a saved assembly file. To help you locate the tool you require, within the 
generator and calculator tool grouped areas, the tools are grouped together in flyout menus 
according to function.

When you have components in an assembly file that were created by a component generator, you 
access the shortcut menu options Edit Using Design Accelerator or Delete Using Design Accelerator 
Component to edit or delete the selected components. To access these shortcut menu options, you 
first select the Design Accelerator created component in the browser or in the graphics window. 

Design Accelerator Library Data

The data used by the Design Accelerator tools is stored in XML files. By default these files are located in 
Inventor\Design Data\Design Accelerator. If you would like a central location for all your design data, 
you can copy the contents of the Design Data folder to another location. Reasons for relocating the 
data can include wanting the data in a shared location so that all design team members access the 
same data, or having data in a location that is automatically backed up for emergency recovery.

If the design data that you want to access is in a different location from the default installation 
location, you must configure Inventor to reference that new location. You can specify the location by 
either changing the path in the Application Options or in the active project file.
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Changing the path in the Design Data field in the Application Options dialog box, File tab, changes the 
default path.

When a project file has the Design Data set to [Default] and that project is active, Inventor references 
the path as specified in the Application Options dialog box. By changing the path for the Design Data 
option, you are specifying a particular path to use when that project file is active.

Example of Design Accelerator

There are many possible uses for Design Accelerator tools. A few of these uses include but are not 
limited to calculating and creating the proper hardware for a bolted connection, creating the correct 
size shaft part, adding an appropriate key way to a shaft and hub, calculating and adding appropriate 
sized springs, and calculating and generating a power transmission system consisting of a belt and 
pulleys or a chain and sprockets. You can also use the tools to calculate design compliance for joint 
size and strength of welded, soldered, and hub joints, to calculate tolerances and fits, to determine 
minimum material thickness for columns or plates, and to conduct calculations for braking 
characteristics. 
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In the following illustration, a two-strand roller chain is in the process of being designed. The graphics 
window shows a preview of the design, and the dialog box lists the information and options that you 
have selected and entered. The preview of the design in the graphics window not only helps you 
visually confirm the design, it also includes grip arrows that you can select to directly manipulate 
your design. 

As the design was being created, it was evaluated for compliance by conducting calculations using 
the current design values and accepted engineering formulas. The calculations for this current design 
indicate it meets the design requirements for the supplied power and speed. 
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About Component Generators

Using component generators, you can spend more time focused on the fit, form, and functionality of 
your design instead of spending time finding and modeling standard content to place in it. You can 
also quickly and easily validate the performance of design content while simultaneously creating the 
design.

In the following illustration, a set of meshed gears is being generated by selecting the shafts they 
assemble to. The left image shows a preview of the parts during their design, and the right image 
shows the generated gears. 

Definition of Component Generators

The component generators are tools that you use to create new part content based on the options 
that you select and the values you enter. Depending on which one of the component generator tools 
you are using, the component generator can create and add newly defined parts to the assembly, add 
Content Center content to the assembly, and create hole features in existing parts in the assembly.

The component generators that add Content Center content can also add your own published 
company-standard parts. To have your published content be used and automatically assembled by 
the component generators, your content must be published to the Content Center using the 
Component Authoring tool. You must also publish the parts to the same library category names as the 
ones from which the component generators retrieve common industry components.

As you define the design in the component generator, a graphical preview of the design displays in 
the graphics window. Not only does this preview assist you by visually confirming your design, 
different previews contain different grips that you can use to dynamically change the position or size 
of the components in your design.

Along with generating part geometry, the component generators also include calculation capabilities. 
After defining the design geometry, you can conduct calculations of the design to ensure that it meets 
or exceeds your requirements before adding the components to your assembly. When you conduct a 
calculation, you can select to export the design information and calculation results to an HTML file so 
that you can easily reference the information again in the future.
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In the following illustration, a small portion of the calculation data exported for a chain design is 
shown. This exported data becomes valuable reference information through the life cycle of 
the design. 

Component Generators

The following table identifies the panel bar icons for the component generator, the titles of the tools, 
and a brief description of their uses or purpose.

 

Icon Generator 
Name

Description

  
Bolted 
Connection

Use to design and create bolted connections. Includes creating 
fastener hardware and holes in parts. 

  
Shaft Use to design and add a part to the assembly in the shape of a shaft. 

  
Parallel Spline 
Connection

Calculate and create parallel spline joints for a new shaft and hub, or 
add to an existing shaft and hub components. 

  
Involute Spline 
Connection

Calculate and create involute spline joints for a new shaft and hub, 
or add to an existing shaft and hub components. 

  
Key Connection Calculate and create a parallel key, and add key ways on the shaft 

and hub parts.

  
Disc Cam Design and insert a disc cam. 

  
Linear Cam Design and insert a part that has a cam profile on one side that 

defines the amount of lift along its length. 

  
Spur Gears Use to design and create a set of gears with straight and helical teeth. 
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Bevel Gears Use to design and create a set of bevel gears with straight and helical 

teeth. 

  
Worm Gears Use to design and create two corresponding worm gears with 

common or spiral teeth.

  
Bearing Calculate and insert roller and ball bearings. 

  
Compression 
Spring

Use to calculate and create compression springs in the state of 
minimum load, working load, maximum load, or to a custom length.  

  
Extension 
Spring

Use to calculate and create extension springs in the state of 
minimum load, working load, maximum load, or to a custom length.  

  
Torsion Spring Use to calculate and create helical torsion springs in the state of 

minimum load, working load, maximum load, or to a custom angle 
between the arms of the spring. 

  
Belleville Spring Use to calculate and create Belleville springs in singles or sets. Sets 

can be stacks in parallel, series, or series and parallel. 

  
V-Belts Use to design, analyze, and generate belts and pulley components 

for mechanical power transmissions of V-belt drives.

  
Synchronous 
Belts

Calculate and create power transmission system consisting of a 
synchronous belt and any number of teethed or flat pulleys. 

  
Roller Chains Use to design, analyze, and generate chain drives consisting of 

sprockets and a chain path.

  
Clevis Pin Use to calculate and insert clevis pin joints. 

  
O-Ring Use to specify and locate O-Rings.

  
Joint Pin Use to calculate and insert a joint pin connection loaded with torque 

parallel to the joint.

  
Secure Pin Use to calculate and insert a securing pin connection loaded with 

shear.

  
Cross Pin Use to calculate and insert a cross pin connection loaded in a draw 

rod and a sleeve.

  
Radial Pin Use to calculate and insert a joint pin connection loaded with torque 

perpendicular to the joint.

Icon Generator 
Name

Description
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Common Interface Options for Component Generators 

The appearance and options in the dialog boxes for the component generator tools vary based on the 
selected tool. Regardless of which tool you select, the interactions are very similar. In the following 
illustration, the primary areas for interaction on the Design tab have been identified. 

 

  Use the options and fields on the Design tab to define the components and their positions in 
your design.

  Activate to enter design use criteria and calculate the results.

  Click to open the File Naming dialog box to enter a new default file name or location for the 
component prior to its creation, or to toggle the setting for the option Always Prompt for 
Filename.

  Use to enable or disable the use of calculations.

  Expansion bar for the Results window. In this display the window is collapsed.

  Expansion bar for the Summary window. In this display the window is collapsed.
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In the following illustration, the primary areas for interaction on the Calculation tab have been 
identified. 

Files and Default File Locations

You use Design Accelerator component generators to define and create parts for your assembly 
design. The actual number of files that you create depends on the component generator tool you are 
using and the values you specified. Regardless of which tool you use, the component generator tool 
creates a phantom assembly component in the active assembly. To help you identify the component 
in the browser, each of these generated phantom assembly components has a unique icon. The icon 
displayed in the browser is similar to the tool’s panel bar icon.

When a component generator retrieves and places a part from the Content Center, that part is 
retrieved and saved according to the path configuration for Content Center content.

 

  Use the options and fields in this area to select and specify your design use criteria and values. 
These options and values are then used to calculate the validity of the selected components 
and values specified on the Design tab. 

  Use to force the calculation of the design based on the specified calculation criteria. 

  Expand the Results window to review the calculated values. When values do not meet the 
design criteria, the values and expansion bar appear in red.

  Expand the Summary window to review a calculation summary. This summary can include 
both statements of success and any identified issues. When values do not meet the design 
criteria, the summary note and expansion bar appear in red.

  Use to export the calculation data and results to an HTML file. 
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The names and locations of part and assembly files created by the component generator have a 
default name and path. You can change the default name and path while you are generating the initial 
design in the File Naming dialog box. When you accept the default name and location, the name of 
the file corresponds to the component generator tool with an incremental numbered suffix. Thus if 
you are creating a bolted connection, the default name for the first bolted connection is Bolted 
Connection1.iam, and for the second is Bolted Connection2.iam.

To separate the components created for the active design from components for other designs, the 
files are created in a unique folder structure for the assembly file you are currently working on. The 
unique folder location occurs when the Design Accelerator tool creates a folder with the same name 
as the current assembly, with a subfolder named Design Accelerator. The generated files are then 
saved in this subfolder.

In the following illustration, different aspects of a partially designed gear box are shown. The image of 
the browser illustrates the different icons and the structure of nesting the components in a phantom 
assembly. The far right image illustrates a merged view of the folders and files for the design when 
using the default generated names and locations. In this example, the assembly file GearBox.iam is 
saved in a folder called Workspace. The default path to separate these generated models from other 
generated models is \GearBox\Design Accelerator. Notice this folder has the same name and is found 
within the same folder as the assembly file for which the components were generated.

Solver Settings

When you generate Design Accelerator content, much of that content has some aspect of its 
definition based on selected geometry from other parts. If the geometry of the other part changes, 
then usually the generated content also needs to change.

All Design Accelerator generated content has three possible settings for solving:

■ Solve Off
■ Manual Solve
■ Automatic Solve

You access these options from the shortcut menu after selecting the Design Accelerator component 
in the browser or graphics window. These shortcut menu options are listed in the Component 
flyout menu.

 

 

 
Browser Model Merged Folder and File List
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The default solver setting is Manual Solve, which means that when a change in the assembly design 
occurs, you must manually update the generated content. You can update the content by either 
selecting the Edit Using Design Accelerator option or the Calculate option.

When a Design Accelerator component is set to Automatic Solve, Inventor continues to evaluate the 
current value for that component and automatically updates it if the geometry that was selected to 
define the content changes.

Sometimes the generated content is not based on other selected geometry or should not be 
changing. In these cases, there is no reason to have the content update or to use the resources to 
calculate if an update is needed. In this type of situation, you want to set the solver setting to Solve Off. 
When set to Solve Off, you can still select Calculate to force the component to reevaluate and update.

Different icons can appear in the browser to the left of the Design Accelerator generated component 
icon, depending on the solver setting and the evaluated state for that component. When the solver is 
set to Solve Off, no other icon other than the component icon appears in the browser. The following 
icons can appear based on the specified settings or conditions.

Example of Component Generators

The component generators make the task of modeling various content easy and quick. In the 
following illustration, a spring set of Belleville springs in a combination of series and parallel are shown 
being defined, and shown with the generated results. The quantity in the stack was quickly set by 
simply clicking and dragging the grip, as shown in the left image.

Indicates that the component is set to Manual Solve

Indicates that the component does not currently match the geometry that was selected to 
define the component and thus requires updating. Only used if the component is set to 
Manual Solve. 

Indicates that the component is set to Automatic Solve.
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About Mechanical Calculators

Ensuring that your design meets the requirements for its use or improving on its current design means 
you are able to create a better product. By not having to spend time validating the selection of 
components through manual calculation, you can create a better product in less time.

To benefit from using the mechanical calculators to perform calculations to ensure a design meets 
your requirements, you should understand the options and capabilities of the mechanical calculators.

Definition of Mechanical Calculators

You use the mechanical calculators to validate and improve upon different aspects of your assembly 
design. While there are calculators associated with the different component generators, there are 
separate calculators focused specifically on returning only engineering calculation data. Just like the 
calculators in the component generators, after you have clicked to calculate the results, you can 
export the calculation data and results to an HTML file for future reference.

When you complete a Design Accelerator mechanical calculation, a phantom assembly component is 
added to the browser for future access and reference. This assembly component does not contain any 
part components, it contains only the Design Accelerator calculation data. By having access to this 
data, you can easily and quickly modify the design calculation criteria and calculate new results.

In the following illustration, a portion of the browser is shown where two components associated to 
mechanical calculations have been added. The browser display for the components has been 
expanded to illustrate that they are an assembly component with no parts defined within them.

Mechanical Calculators

The following table identifies the panel bar icons for the mechanical calculator, the titles of the tools, 
and brief descriptions of their uses or purpose.

 

Icon Calculator Name Description

  
Plain Bearing Calculate and validate plain bearing designs working under 

hydrodynamic lubrication conditions.

  
Plug and Groove 
Weld

Perform strength checks for plug and groove welds based on 
different load values and on the weld joint material and size. 

  
Butt Weld Perform strength checks for butt welds based on different weld 

designs, load values and directions, and on the weld joint material 
and size. You can also calculate fatigue loading on the weld.

  
Spot Weld Perform strength checks for statically loaded spot welds based on 

different weld designs, load values, and on the weld joint material 
and size.
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Fillet Weld 
(Connection 
Plane Load) Weld

Perform strength checks for fillet welds loaded in the connection 
plane. Calculation results are based on different weld forms, load 
values, load directions, and on the weld joint material and size. You 
can also calculate fatigue loading on the weld.  

  

Fillet Weld 
(Spatial Load) 
Weld

Perform strength checks for fillet welds spatially loaded. 
Calculation results are based on different weld forms, load values, 
load directions, and on the weld joint material and size. You can 
also calculate fatigue loading on the weld. 

  

Butt Solder Joint Calculate the strength of a butt solder joint based on load, part 
width and thickness, and solder joint material.

  

Bevel Solder Joint Calculate the strength of a soldered joint on a beveled angle based 
on load, part width and thickness, bevel joint angle, and solder 
joint material.

  

Lap Solder Joint Design or check the strength of a lap solder joint based on load, 
part properties of width, thickness, overlap, and material, and 
solder joint material.

  

Step Tube Solder 
Joint

Design or check the strength of a step solder joint of tube parts 
based on load, properties of the tube parts, and solder joint material.

  

Step Solder Joint Design or check the strength of a step solder joint of cylindrical 
stock and a hole in a part. Calculation results are based on load 
force and torque, material of the parts, diameter and depth of the 
step, and solder joint material.

  

Separated Hub 
Joint

Use to calculate and design clamping joints of a cylindrical part 
where the clamp is split into two halves and bolted on each side.

  

Slotted Hub Joint Use to calculate and design clamping joints of a cylindrical part 
where the clamp is one piece of material pulled together by a bolt. 

  

Cone Joint Calculate the required pressure, pressing force, and releasing for a 
cone joint where a hub is pressed on the cone end of a shaft.

  

Tolerance Use to calculate a resulting tolerance based on the dimensions 
with tolerances you configure. 

  

Limits and Fits Calculate hole, shaft, and clearance or interference values for 
different limits and fits settings. 

  

Press Fit Use when designing a press fit of a shaft and hub to calculate 
pressing force, contact pressure, expansion and reduction in the 
diameters, interference, and forces and torques. 

  
Power Screw Design or check the strength of a power screw to ensure it meets 

the required load. 

Icon Calculator Name Description
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Example of a Mechanical Calculator

In the following illustration, the Plate Calculator is shown being used to evaluate the strength of a 
plate for a specified load and deflection. Based on the calculated values, it can be determined whether 
thicker material is required or thinner material can be used. Being able to determine whether you can 
use thinner material and still exceed your engineering requirements is especially important in the 
transportation industry, where the reduction of overall weight is important. 

  
Beam and 
Column

Use to analyze forces, deflections, loads, and stresses on beam or 
column members. 

  

Plate Use to design or check the strength of flat plates in circular, square, 
or rectangular shape by calculating the rotation at the support 
position, maximum stress, and factor of safety. 

  

Shoe Drum Brake Use to design and calculate shoe drum brakes. Calculation results 
include the necessary revolutions for stopping, initial speed, 
friction area, braking friction force, and moment of inertia.

  

Disc Brake Use to design and calculate disc brakes. Calculation results include 
the necessary revolutions for stopping, initial speed, friction area, 
braking friction force, and moment of inertia.

  

Cone Brake Use to design and calculate cone brakes. Calculation results 
include the necessary revolutions for stopping, initial speed, 
friction area, braking friction force, and moment of inertia.

  

Band Drum Brake Use to design and calculate band drum brakes. Calculation results 
include the necessary revolutions for stopping, initial speed, 
friction area, braking friction force, length of the band arc, output 
force, and moment of inertia.

 

Icon Calculator Name Description
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About the Engineer’s Handbook

As you conduct calculations as part of generating a component, or as stand-alone calculations, you 
automatically apply different engineering principles and formulas. By understanding the purpose of 
the Engineer’s Handbook and how to access it, you can use the Engineer’s Handbook to conduct those 
calculations with full understanding and confidence. 

Definition of the Engineer’s Handbook

The Engineer’s Handbook consists of information and descriptions specific to the formulas and 
calculations being used by the different Design Accelerator generators and calculators. You access the 
Engineer’s Handbook to help you identify, analyze, and review the variables and formulas being used. 
This knowledge and analysis help ensure that you supply the correct data and achieve valid results. 

Access

Example of the Engineer’s Handbook

Different categories of content in the Engineer’s Handbook contain different amounts of information 
depending on the amount of supporting information needed for the topic. In the following 
illustration, before the calculation and creation of a compression spring, the defining variables and 
formulas that are entered and used in the generator are being reviewed in the Engineer’s Handbook. 

  

Engineer’s Handbook

  

Panel Bar: Design Accelerator
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Exercise: Review Design Accelerator Models and Data

In this exercise, you develop a sense of the Design 
Accelerator tools by reviewing generated content in 
the browser and the dialog box interface for the tools 
used to generate the content. You review the dialog 
box interface by selecting to edit the existing Design 
Accelerator generated content. You also view some 
of the information available in Inventor’s Engineer’s 
Handbook. 

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of chapters 
and exercises, click Chapter 4: Design 
Accelerators. Click Exercise: Review 
Design Accelerator Models and Data.

1. Open Blower Assembly-DA.iam.

  

2. In the graphics window, right-click the large 
sprocket for the chain drive as shown. Click 
Find in Browser.

  

3. In the browser, expand the display for Chain 
Drive:1 as shown. Review the icons for the 
Design Accelerator created chain drive. 
Review the parts contained within the chain 
drive design.
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4. In the browser, right-click Chain Drive. Click 
Edit Using Design Accelerator.

5. In the Roller Chains Generator dialog box, 
review the settings and selections in the 
Chain area and Sprockets area that define this 
chain drive system.

  

6. In the graphics window, review the display of 
the grips for the different components 
associated with the chain drive.

  

7. In the Roller Chains Generator dialog box, 
click the Calculation tab. Review the 
availability of conducting different working 
calculations to validate design compliance.

  

8. In the Roller Chains Generator dialog box, 
click Cancel.

9. Zoom in to the back left corner of the electric 
motor mounting bracket as shown.

  

10. In the graphics window, right-click the spring 
as indicated. Click Edit Using Design 
Accelerator.
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11. In the Belleville Spring Generator dialog box, 
review the interface and options for this 
Design Accelerator tool. Click Cancel.

  

12. To access the Engineers Handbook:

■ Click Design Accelerator on the Assembly 
Panel menu.

■ On the panel bar, click Engineer’s 
Handbook.

  

13. In the Contents list, expand the categories. 
Under Compression Spring Generator, click 
Basic Concepts.

  

14. In the pane on the right, view the available 
engineering concept information. 

15. Click other content areas to see what other 
information is available for your review and 
learning.

16. Close the Engineer’s Handbook window.

17. Save and close all files. 
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Lesson:  Bolted Connections

Overview

This lesson describes using the Bolted Connection Component Generator to create and edit bolted 
connections in an assembly.

Bolted connections are the most common fastening method used in mechanical design. The ability to 
efficiently implement standard fasteners in an assembly streamlines the design process. As designs 
and specifications change, it is important to be able to edit the fasteners and the related components 
in the bolted connection, and to match those specifications.

In the following illustration, bolted connections are used to secure the lids to the reservoirs, and to 
secure the reservoirs to the mounting plate. At final assembly, additional bolted connections will be 
used to fasten the mounting plate in location.

Objectives

After completing this lesson, you will be able to:

■ Define the characteristics of a bolted connection.
■ Describe the options available for creating a bolted connection using the Bolted Connection 

Component Generator.
■ Create bolted connections in an assembly.
■ Edit bolted connections in an assembly.
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About Bolted Connections

The most common method to hold two or more parts together is to use mechanical fasteners. Placing 
just one set of bolts, washers, and a nut into an assembly can be a time-consuming process. Having to 
add holes to each part where the fasteners pass through, and checking to make sure the selected 
fasteners meet your overall design requirements, adds even more time to the design task. By using the 
Bolted Connection Generator, you can accomplish all of those tasks during the process of defining the 
fastener set.

In the following illustration, a bolted connection composed of multiple components extends through 
three different parts. During the creation of this bolted connection, a new hole was automatically 
created in each of the three parts.

Definition of a Bolted Connection

Using the Bolted Connection Component Generator in the assembly environment, you can size, 
create, and place mechanical fastener connections automatically according to data you select and 
supply. By supplying additional physical property data on the Calculation tab, you can determine the 
required bolt diameter, number of bolts, or material. You can use this data to determine the proper 
fastener size, and then export the calculated results for reference. The fasteners added to the assembly 
are based on the fasteners defined in the Content Center.

To position a bolted connection, you use methods and options similar to those used when placing a 
hole with the Hole tool. You can place bolted connections in existing holes or create new holes based 
on the bolt’s defined placement. Existing holes must be features within the part, not assembly 
features. Holes created while generating a bolted connection are created in the part file. Because a 
single bolted connection can pass through multiple parts, you define holes for each and every part 
that the connection passes through. You create and size these holes during the process of defining the 
bolted connection. After you create a connection, you can change or delete the fastener’s type and 
values. When deleting a connection that also created holes in parts, you can keep those holes or 
delete them.
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In the following illustration, a bolted connection is being positioned from two linear edges and will 
extend through three parts while creating new holes in each of the parts.

Example of a Bolted Connection Configuration

In the following example, a bolted connection must be positioned from the edges of a part and pass 
through three different parts. Because the parts do not currently have holes at those locations, three 
new holes are added to the configuration list on the right. The first hole is modified to be sized for a 
loose fit instead of a normal fit. The bolt, washers, and nuts are then added to the configuration after 
clicking the text Click to Add a Fastener located in the configuration list.

The Calculation tab is accessed to specify operational criteria for the fastener. The calculation results 
state the current designs are within compliance. The summary message indicating these results is 
shown in the expanded Summary window.

 

 

Lesson:  Bolted Connections ■ 221



With the dialog box expanded, you see the list of saved bolted connection templates. Use this area to 
save and reuse a bolted connection configuration.

Bolted Connection Generator

The Bolted Connection Component Generator enables you to create a series of related parts that 
define a bolted connection. In addition to the nuts, bolts, screws, and washers selected, the Generator 
also creates placed features in the part based on the settings chosen.

For example, you have the option to edit the hole for the fastener and specify a normal, loose, custom, 
or threaded type of hole. Even though you are in the assembly environment, the holes placed using 
the Generator are part features, not assembly features. They are added to the part and are editable in 
the part environment.
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Bolted Connection Component Generator Dialog Box

The following options are available in the Bolted Connection Component Generator dialog box.

 

  Use to specify the type of bolted connection to be created. Choose from Through All or Blind.

  Use to specify the placement option. Choose from Linear, Concentric, On Point, or By Hole.

  A list of fasteners and holes that define the bolted connection.  

  Use to specify the units and nominal size of the bolted connection.

  Resulting messages from Calculations.

  Use to store and retrieve bolted connections.

  Click to enable calculations. After calculations are enabled, click the Calculation tab to select 
and enter the calculation information.
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Creating Bolted Connections

Bolted connections are created based on your input and the parts in the assembly. When inserting 
bolted connections, you define the size, type, and components of the bolted connection. You also 
define the location of the bolted connection. When you select the starting and termination planes, the 
length of the fasteners is determined based on the planes selected and the standard sizes defined in 
the Content Center.

In addition, if the fastener requires holes to be created, the Generator creates these holes based on the 
size of the fastener, and the type of hole needed. As with the fastener length, the hole sizes generated 
are based on Content Center values.

In the following illustration, bolted connections are used to fasten a casting to its base. Additional 
bolted connections are used to fasten a plate to cover an opening during shipping.

Access

 

  

Bolted Connection Generator

  

Panel Bar: Assembly Panel

Panel Bar: Design Accelerator

Toolbar: Design Accelerator
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Procedure: Creating Bolted Connections

The following steps describe adding a bolted connection to an assembly using the Bolted Connection 
Component Generator.

1. Start the Bolted Connection 
Component Generator.

  

2. Specify the diameter.

  

3. Specify the connection type.

  

4. Locate the bolted connection.
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Key Points

As you add bolted connections to your assembly design, keep the following key points in mind:

■ Holes listed in the component list of the Bolted Connection Component Generator dialog box are 
features created in the part modeling environment.

■ To aid in searching the Content Center for fasteners, and display hole sizes in the component list 
of the Bolted Connection Component Generator, set the fastener diameter first.

■ To display dimensions for creating and editing the location of bolted connections, ensure that the 
Edit Dimension When Created option is selected on the Sketch tab of the Application Options 
dialog box. 

5. Define the components.

  

6. Apply the bolted connection.
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Editing Bolted Connections

When editing bolted connections, you use the same dialog box you used to create the bolted 
connection. To edit the bolted connection, you locate the bolted connection in the browser or 
assembly, right-click the bolted connection, and click Edit Using Design Accelerator. In addition to 
changing the size or type of fastener used, you can use the Bolted Connection Component Generator 
dialog box to change the location of the bolted connection, or even move the connection to a new 
plane on a different part.

The following illustration shows how the Edit Using Design Accelerator option is available when you 
right-click a bolted connection in the graphics window.

Access

 

  

Edit Bolted Connection

  

Browser: Right-click, click Edit Using Design Accelerator.

Component: Right-click, click Edit Using Design Accelerator.
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Procedure: Editing a Bolted Connection

The following steps describe editing a bolted connection.

1. In the browser or the graphics window, 
right-click the bolted connection. Click Edit 
Using Design Accelerator.

  

2. Use the Bolted Connection Component 
Generator dialog box to edit the type, 
placement, size, or components of the 
bolted connection.

  

3. Click OK.

  

Add Existing Bolted Connection to the Template Library
To reuse a bolted connection in your assembly, right-click the bolted connection and click Edit 
Using Design Accelerator. When the Bolted Connection Component Generator displays with the 
component list populated, expand the dialog box and under the Templates Library, click Add. The 
bolted connection is added to your template library for use in other applications.
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Exercise: Create and Edit Bolted Connections

In this exercise, you use the Bolted Connection 
Component Generator to create bolted connections, 
add a bolted connection to the templates library, 
insert new bolted connections from  the templates 
library, and edit bolted connections.

Create a Blind Bolted Connection

In this section of the exercise, you create a blind 
bolted connection using the Bolted Connection 
Component Generator. You also create templates of 
your bolted connections.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of chapters 
and exercises, click Chapter 4: Design 
Accelerators. Click Exercise: Create and 
Edit Bolted Connections.

1. Open Control_Module_Mount.iam.

  

2. To view the location for the bolted 
connection, zoom in to the corner of the 
housing and lid.

  

3. To specify the type and size of a bolted 
connection:

■ On the Assembly Panel, click Bolted 
Connection Generator.

■ Under Type, click Blind Connection.
■ Under Thread, for diameter, select 4 mm.
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4. To locate the bolted connection:

■ Under Placement, select Concentric.
■ Click Start Plane. Select the top of the 

housing lid (1).
■ For Circular Edge, select the radius (2).
■ For Blind Start Plane, select the top of the 

housing body (3).

  

5. To specify a fastener:

■ Click the text Click to Add a Fastener.
■ For Standard, select ISO. For Category, 

select Bolts.
■ Click ISO 7047 (H).

  

6. To access the features of a hole:

■ Under Click to Add a Fastener, click ISO 
Drilled Hole Threaded M4x0.7 6H.

■ To edit the drill depth of the tapped hole, 
click the More button.

 

7. To edit the hole values:

■ In the Modify Hole dialog box, under Hole 
Depth, enter 12 mm.

■ Click the check mark.

  

8. To create a template of the bolted 
connection:

■ In the Bolted Connection Component 
Generator dialog box, click More 
Options (1).

■ Under Templates Library, click Add (2).
■ In the Template Description dialog box, 

click OK.
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Create Through All Bolted Connections

In this section of the exercise, you create a Through 
All bolted connection using the Bolted Connection 
Component Generator. You create templates of your 
bolted connection and insert new connections 
based on these templates.

9. To add the bolted connection to the assembly:

■ In the Bolted Connection Component 
Generator, click Apply.

■ In the File Naming dialog box, click OK.
■ In the Bolted Connection Component 

Generator, click Cancel.

  

10. To view the holes created by the bolted 
connection:

■ In the browser, right-click Bolted 
Connection:1. Click Visibility.

■ After viewing, restore the visibility of the 
bolted connection.

  

1. To specify the type and size of a bolted 
connection:

■ On the Assembly Panel, click Bolted 
Connection Generator.

■ Under Type, click Through All 
Connection.

■ Under Thread, for diameter, select 
10 mm.

2. To locate the bolted connection:

■ Under Placement, select Concentric.
■ Click Start Plane. Select the top of the 

mounting tab on the housing (1).
■ For Circular Edge, select the hole (2).
■ For Termination, select the bottom face 

of the Mounting Plate (3).

  

3. To specify a fastener:

■ Click the text Click to Add a Fastener.
■ Under Standard, select ISO. For Category, 

select Bolts.
■ Click ISO 8676.
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4. To specify an additional fastener, in the list of 
fasteners, click the first Click to Add a Fastener 
text.

  

5. To specify a washer for the bolted 
connection, from the available washers, 
select ISO 7089.

  

6. To add components to the other side of the 
bolted connection, click the second Click to 
Add a Fastener text, as indicated.

  

7. To specify a lock washer:

■ For Standard, select ANSI.
■ Verify that the category is Washers.
■ From the available options, select the 

ASME B18.21.2M Regular Helical Spring 
Lock Washer.

  

8. To add the nut and complete the bolted 
connection:

■ Click the last Click to Add a Fastener text.
■ For Standard, select ISO. For Category, 

select Nuts.
■ Click ISO 8674.

  

9. Review the current bolted connection.
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10. To create a template of the bolted connection:

■ Under Templates Library, click Add.
■ In the Template Description dialog box, 

click OK.

  

11. To add the bolted connection to the assembly:

■ In the Bolted Connection Component 
Generator, click Apply.

■ In the File Naming dialog box, click OK.
■ In the Bolted Connection Component 

Generator, click Cancel.

  

12. To specify the type and size of a bolted 
connection:

■ On the Assembly Panel, click Bolted 
Connection Generator.

■ Under Type, click Through All 
Connection.

■ Under Thread, for diameter, select 
10 mm.

13. To locate the bolted connection:

■ Under Placement, select Concentric.
■ Click Start Plane. Select the top of the 

offset mounting tab on the housing (1).
■ For Circular Edge, select the hole (2).
■ For Termination, select the bottom face 

of the Mounting Plate (3).

  

14. To preview a bolted connection from a 
template:

■ In the Bolted Connection Component 
Generator, under Templates Library, click 
ISO 8676 M10 x 1 x 25.

■ Click Set.
■ The components display in the dialog 

box and preview in the drawing.
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Edit Bolted Connections

In this section of the exercise, you edit individual 
components of a bolted connection and change the 
type of fasteners used in a bolted connection. You 
create a template of the changes and use the 
template to complete the assembly.

15. To insert the bolted connection from a 
template:

■ In the Bolted Connection Component 
Generator dialog box, click Apply.

■ In the File Naming dialog box, click OK.
■ Click Cancel to exit the dialog box.

  

16. Using templates, add the remaining five 
bolted connections to complete the design.

  

1. To better view the edits to the bolted 
connection:

■ In the browser, right-click 
MountingPlate:1.

■ Click Enabled.

  

2. To access the Bolted Connection Component 
Generator for editing:

■ Right-click the back, right bolted 
connection.

■ Click Edit Using Design Accelerator.
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3. To change the length of the bolt, in the 
drawing area, click and drag the 3D grip to 80.

  

4. In the Bolted Connection Component 
Generator dialog box, click OK.

5. Rotate the view to see both long bolted 
connections.

  

6. Restore the Home view, and zoom in on the 
right front bolted connection of the lid.

  

7. To access the Bolted Connection Component 
Generator for editing:

■ Right-click the bolted connection. Click 
Edit Using Design Accelerator.

■ In the Bolted Connection Component 
Generator, click ISO 7047 (H) 
M4x10 - 4.8 - H.

■ Click the down arrow as indicated.

  

8. To change fasteners:

■ In the list of fasteners, under Category, 
select Socket Head Bolts.

■ Select ISO 4762.
■ Under Templates Library, click Add. For 

Template Description, Click OK.
■ In the Bolted Connection Component 

Generator, click OK.
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9. To edit another bolted connection:

■ Right-click the left front bolted 
connection. Click Edit Using Design 
Accelerator.

■ Under Template Library, click 
ISO 4762 M4 x 10.

■ Click Set.
■ Click OK.

  

10. To complete the design:

■ Update the remaining two bolted 
connections for the lid.

■ In the browser, right-click 
MountingPlate:1. Click Enabled.

  

11. Save and close all files.
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Lesson:  Shaft Generator

Overview

In this lesson, you learn about creating shaft components in the context of an assembly, using 
predefined shape elements to quickly create the geometry.

When you use the Shaft Generator to create and edit a shaft design, predefined shapes help ensure 
that the model conforms to industry standards. Editing your shaft design is easier and quicker than 
editing shafts that are created using sketched and placed feature-based modeling techniques, 
because of the ease-of-use and consistent modeling techniques offered with the Shaft Generator.

The following illustration shows a common use of shafts in a design. In the blower motor assembly, 
shafts are required to transmit power from the electric motor to the blower fan.

Objectives

After completing this lesson, you will be able to:

■ Define the characteristics of a shaft created with the Shaft Generator.
■ Create shafts using the Shaft Generator.
■ Edit shafts using the Shaft Generator.
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About the Shaft Generator

You use the Shaft Generator to create and edit shaft designs by combining individual shaft sections in 
the assembly environment. The shaft sections provided with this tool include the most common 
geometry found in shafts. You can base your shaft designs on data you input, part geometry in the 
assembly, and load calculations provided in the Shaft Component Generator dialog box.

The following illustration shows a shaft design for an auxiliary pump. A variety of input data is used to 
design the shaft. In addition to the loads on the shaft and the required volume output, the shaft needs 
to fit with parts from previous designs.

Definition of the Shaft Generator

The Shaft Generator provides a series of tools that enable you to design and edit a shaft, section by 
section. As you design the shaft, you can add multiple features to fully define each section. You can 
also perform calculations and create output graphs based on the loads applied to the shaft.
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The following illustration shows the Calculation tab of the Shaft Component Generator dialog box. 

Example Shaft from the Shaft Generator

The following illustration shows a shaft design that was created using the Shaft Generator. 

Multiple features were added to the shaft sections to perform the tasks of rotating, sealing, and 
locating the various parts that will be connected to the shaft. The features on this shaft design include:

 

 

■ Internal bores, cylinder
■ Locknut
■ Hole
■ O-ring groove
■ Transition fillet
■ Installation chamfer (break sharp edge)
■ Cylindrical diameter change

■ Cone diameter change
■ Chamfer
■ Cylindrical diameter change
■ Snap ring grooves
■ Keyway
■ Internal bore cone (not visible)
Lesson:  Shaft Generator ■ 239



Creating Shafts

The Shaft Generator tool is used for the design and creation of feature-rich, intelligent shafts. Shafts 
are created in sections and each section can maintain a different diameter and length. Many different 
features such as retaining ring grooves, tapers, and undercuts can be added to each of the sections. 
Loads and forces can also be applied during the design process. 

In the following illustration, a shaft is created using the Shaft Component Generator. Currently, a 
chamfer is being added to the first segment of the shaft.

Access

Shaft Component Generator Dialog Box

The Shaft Component Generator dialog box offers multiple tabs for designing and analyzing a shaft. 
You use the Design tab to create your shaft design, and the Calculation and Graphs tabs to analyze the 
shaft while you design. In addition to the dialog box, the graphics area displays a 3D shaft preview 
based on the current settings in the dialog box. You can also quickly modify each section of your shaft 
using the grips provided on the 3D preview.

 

  

Shaft Generator

  

Panel Bar: Design Accelerator

Toolbar: Design Accelerator
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The following illustration shows the Shaft Component Generator dialog box and the interactive 3D 
shaft preview. The four default Section trees illustrated are displayed when you first use the tool, 
enabling you to immediately begin your shaft design.

The following options are available for designing, locating, calculating, and saving shaft designs.
 

 

  Design tab: Use to design a shaft. Calculation tab: Use to set material, loads, and supports to 
calculate the shaft. Graphs tab: Use to display a diagram of shaft loads.

  Use to locate the shaft in the assembly. Define the axis, start plane, and orientation.

  Use to add cylinder, cone, or polygon sections to your shaft.

  Use to expand all, collapse all, or set options for the section tree display.

  Use to define each section of your shaft design. Specify shape and size of the section. 
Add features to each section. Drag to reorder a section.

  Use to specify the size of the base feature.
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Sections Area

You use the options in the Sections area of the Shaft Component Generator dialog box to control the 
shape and size of each shaft segment, to add features to a section, and to add bores to either end of 
the shaft. The Sections drop-down list has three options to define the working location: Sections, Bore 
on the Left, and Bore on the Right.

The default Sections option enables you to add multiple sections to the shaft. You can add cylinders, 
cones, and polygons and split an existing section into two sections. Each time that a section is added, 
and new row is added to the section tree for further refinement.

The Bore on the Left and Bore on the Right options enable you to add internal shaft features. You can 
add cylindrical or conical bores to the shaft. Each time that a bore is add to the shaft, a new row is 
added to the section tree for further refinement.

Further refinements for a section or bore can include adding features to the section, changing the 
section type, or adjusting the size. You make these refinements in the list after selecting that 
section or bore.

Section Tree

The Section tree area of the Shaft Component Generator dialog box is where the majority of the shaft 
design is accomplished. Each Section tree row is broken down into four groups. After the shape and 
size of the shaft section have been specified, you can add features to the section based on options 
available from these four groups. The options available vary depending on the shape selected, and 
other options already applied. 

  Use to expand the Design tab and display information regarding each shaft section in a text 
format.

  Use to expand the Design tab to display calculation messages.

  Use to toggle the display of the Shaft Component Generator dialog box to display the 
Templates library.
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The following illustration identifies the primary options available for editing and defining a shaft 
section. The available options and features depend on the type of section.

To display a 2D dynamic preview of the shaft that you are designing, in the Shaft Component 
Generator dialog box, Sections area, click Options. In the Options dialog box, 2D Preview area, click 
Always Show.

 

  Add features on the left edge of the shaft section.

  Change the current section type.

  Add features on the right edge of the shaft section.

  Add features to the shaft section.

  Click here to select the section. Double-click here to open the corresponding dialog box to edit 
size or position values. 

  Click to open the corresponding dialog box to edit size or position values.

  Click to delete the section or feature from the list.
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Edge Features

After you add an external shaft section to a shaft design, you can edit the section to add edge features 
or insert features into the section. The list of edge feature options for a shaft section is dependent on 
the type of section and on the existence and diameter of any adjacent shaft sections. For example, 
keyways are not added to polygon sections, and reliefs are only added to a section if the adjacent 
section has a larger diameter. 

First and second edge features are set by selecting the section tree option for the selected section 
as identified. 

The following table lists the edge features that you can select for a shaft section.
 

Icon Option Example

  No Feature
Select to clear any edge treatments and set the left or right edge to have 
a sharp edge transition.

  

  Chamfer
Select from the edge section option list to add a chamfer to the left or 
right edge of the shaft section.

Use to add an angle break at the end of shaft section, or to provide a 
transition between to shaft sections. Chamfers are constructed using 
one of the following three methods: Distance, Distance and Angle, and 
Two Distances.

  

  Fillet
Select from the edge section option list to add a fillet or round to the left 
or right edge of the shaft section.

Use to add a rounded shape to the outside edge of a shaft section, or to 
provide a transition between different shaft sections.   

  Lock Nut Groove
Select from the edge section option list to add external threads and a 
lock groove cut in the end of the shaft section. 

The Lock Nut Groove dialog box enables you to select from a list of 
standard locknut grooves, or you can define custom settings.   

  Thread
Select from the edge section option list to add external threads to the 
left or right end of the shaft section.
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Section Types

The outer shape of the shaft is defined by different sections that you add or edit independently of each 
other. The section types you select to add to a shaft are the same section types you can select from 
when editing a shaft section. When you click to add a section to a shaft, that section is added directly 
after the currently selected section. 

You change the section type by selecting the section tree option for the selected section as identified. 

  Plain Keyway Groove
Select from the edge section option list to add a keyway groove that 
starts at the end of the shaft section and continues into the shaft section 
with the groove arcing up to the diameter of the shaft section.

  

  Keyway Groove with One Rounded End
Select from the edge section option list to add a keyway groove that 
starts at the end of the shaft section and continues into the shaft section 
with a rounded end similar to the rounded end of a slot.

  

  
Reliefs (SI Units)
Click from the edge section option list to display a list of relief types that 
adhere to the SI standards and then select the required relief type from 
that list.

  

  
Reliefs (DIN)
Click from the edge section option list to display a list of relief types that 
adhere to the DIN standard and then select the required relief type from 
that list.

  

  
Reliefs (GOST)
Click from the edge section option list to display a list of relief types that 
adhere to the GOST standard and then select the required relief type 
from that list.

  

 

Icon Option Example
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The following table lists the types of sections you can add to a shaft.

Section Features

After you add an external shaft section to a shaft design, you can edit the section and insert one or 
more features into the section. The difference between section features and end features is that when 
you insert a section feature, you specify where the feature is located between the edges of that shaft 
section. Section features also display in the list of shaft features as nested features to the shaft section 
where they were inserted.

In the following illustration, the retaining ring groove is a section feature that was inserted on the shaft 
section listed above this row. 

Icon Option Example

  Cylinder
Inserts or changes to a standard constant diameter cylindrical shaped 
shaft section. 

Use to add cylindrical shaft sections. Cylinders are a base feature for 
shaft design. Additional features such as keyways, retaining rings, 
through holes, grooves, reliefs, and wrenches can be added to shaft 
sections. The length and diameter of cylinders can be changed 
using grips.

  

  Cone
Inserts or changes to a conical section that has different diameters for 
its left and right ends.

Use to add a cone shape to a shaft. The cone is a base feature for shaft 
design. Fillets and chamfers can be added to cone sections. If the 
cone section is in between two other shaft sections, both cone 
diameters are initially controlled by the adjacent sections. To change 
either diameter of the cone section independently, you must first 
unlock the variables controlling their size using the Edit option. You 
can adjust the length and both diameters with grips.

  

  Polygon
Inserts or changes to a shaft section with three or more sides.

Use to add a section to a shaft with three to 50 flat sides. Polygons are 
a base feature for shaft designs. Through holes can be added to 
polygon sections. Use grips to change the length, section diameter, or 
to rotate the section.
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You insert a feature onto the selected section by selecting a section feature option after clicking the 
identified section tree option.

The following table lists the features that you can select to insert between the edges of a shaft section.
 

Icon Option Example

  Add Keyway Groove
Select to insert a keyway groove somewhere on this section that is based 
on a selected industry key.

Use to add a slot to a shaft section. A keyway groove is used to lock 
rotation between the shaft and added components. The keyway sizes are 
generated from industry standards. The Keyway dialog box enables you 
to create a custom keyway and to insert parts from the Content Center.

 

  Add Retaining Ring
Select to insert a retaining ring groove somewhere on this section that is 
based on a selected industry retaining ring.

 

  
Add Wrench
Select to create two flat cuts across the section so a wrench can fit.

 

  Add Relief - D (SI Units)
Select to insert a circular groove that adheres to the relief-D shape 
and SI units.

 

  Add Through Hole
Select to insert a hole that is perpendicular to the axis of the shaft.

 

  Add Groove - A
Select to insert a circular groove that adheres to the Relief-A shape.

 

  Add Groove - B
Select to insert a circular groove that adheres to the Relief-B shape.
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Bore Types

You add bore sections to the left or right end of the shaft after selecting Bore on the Left or Bore on 
the Right from the section’s working location list. After you select the left or right bore option from the 
list, the options for the type of section insert change from external sections to internal bore sections. 
Clicking a bore type adds it to the list of bore sections directly after the currently selected section. You 
can insert multiple bore sections on the end of the shaft. 

Bore sections are added to the shaft starting from the left or right end and extend into the shaft. The 
center axis of the bore section is colinear to the center axis of the shaft. 

After you have added a bore section, you can change it from one type to another. To change the bore 
type, select the bore section in the list of sections and then select the new bore type. 

The following table lists the types of bore sections you can add to a shaft. 

Bore Features 

After adding a bore section, you can edit the section to add edge features and insert features into the 
section just like you do for an external section. The difference between external section features and 
bore features are the available options that you can select to add as an edge or inserted feature.

The following table lists the edge and insertion options that you can add to a bore. 

Icon Option Example

  Cylindrical Bore
Inserts or changes to a standard constant diameter cylindrical shaped 
hole in the end of the shaft.

  

  Conical Bore
Inserts or changes to a tapered shaped hole that has different 
diameters for its left and right ends.

  

Icon Option Example

  No Feature
Select to clear any bore treatments and set the left or right edge of the 
bore to have a sharp edge transition.   

  Chamfer
Select from the edge section option list to add a chamfer to the left or 
right edge of the bore.   

  Fillet
Select from the edge section option list to add a fillet to the left or right 
edge of the bore.   
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Sizing Shaft Sections with Grips

Any time that the Shaft Component Generator dialog box is displayed, grips are displayed in the 3D 
preview for the active section. You can switch the active section by selecting it in the graphics window 
or the dialog box, then selecting the grip and dragging to a new size.

Using grips enables you to size the shaft section based on visual feedback in the assembly. Grips 
enable you to efficiently resize the length and diameter of cylindrical or conical shaft sections, the 
outside diameter, length, and rotation angle of a polygon shaft section, and also the size and 
orientation of other features like keyways and through holes that you add to a section.

The following illustration shows how the cylinder length and diameter for a section of the shaft can be 
modified using grips.

  Thread
Select from the edge section option list to add internal threads to the bore 
in the shaft.   

  Add Retaining Ring
Select from the section features option list to add a retaining ring to the 
bore.   

 

Icon Option Example
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Process: Creating a Shaft

The following steps describe creating a shaft and adding it to your assembly using the Shaft 
Generator.

1. Access the Design Accelerator panel bar.

  

2. Start the Shaft Generator tool.

  

3. Add or remove sections.

  

4. Size the sections.
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Editing Shafts

When editing shafts, you use the same dialog box, methods, and features used to create the shafts. To 
edit a shaft, you locate the shaft in the browser or graphics window, right-click the shaft, and click Edit 
Using Design Accelerator. In addition to changing the size or type of shaft, you can use the Shaft 
Component Generator dialog box to change the location of the shaft. 

5. Add features to sections.

  

6. Add bores to the shaft ends.

  

7. Add the shaft to the assembly.
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In the following illustration, a section of a shaft is being edited. After assembling the physical 
prototypes, it was determined that a radius needed to be added to a section to minimize the 
possibility of damage during assembly.

Access

 

Migrating Shafts
Shaft parts created with the Shaft Generator prior to the release of Inventor 2008 are not 
directly editable with the Shaft Generator tool. To edit the shaft, the Shaft Generator must first 
migrate the pre-Inventor 2008 version by creating and inserting a new shaft part based on the 
selected existing shaft. 

  

Edit Shaft

  

Browser: Right-click, click Edit Using Design Accelerator.

Component: Right-click, click Edit Using Design Accelerator.
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Procedure: Editing a Shaft Created with the Shaft Generator

The following steps describe editing a shaft that was created using the Shaft Generator.

1. Locate the shaft in the graphics window or 
browser. Right-click and click Edit Using 
Design Accelerator.

  

2. In the Shaft Component Generator dialog 
box, select the segment to be edited and 
change the features or size in the dialog 
box, or use 3D grips.

  

3. Click OK to accept the edits.
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Exercise: Create and Edit Shafts

In this exercise, you create a shaft using the Shaft 
Generator.  While most of the shaft design is based 
on known size requirements, one section of the shaft 
is based on data obtained from another part in the 
assembly. You edit the shaft, and save the shaft to 
the Template Library for future reference.

Create a Parametric Shaft

In this section of the exercise, you create a shaft with 
the Shaft Generator. You change shaft sections, and 
add features to the sections.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of chapters 
and exercises, click Chapter 4: Design 
Accelerators. Click Exercise: Create and 
Edit Shafts.

1. Open Shaft_Generator.iam.

  

2. To access the Shaft Generator:

■ In the Assembly Panel menu, click Design 
Accelerator.

■ Click Shaft Generator.

3. To set the Shaft Component Generator to 
default values:

■ In the Shaft Component Generator dialog 
box, click Reset Calculation Data as 
indicated.

■ In the Design Accelerator message box, 
click OK.

  

4. To assign a new section type:

■ In the Shaft Component Generator dialog 
box, under Sections, in the first Section 
tree, next to Section Type, click the down 
arrow.

■ Click Polygon.
■ In the Design Accelerator notice, click Yes.
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5. To define the section values:

■ With the polygon Section tree row 
highlighted, click Section Properties.

■ In the Polygon dialog box, for Inscribed, 
clear the check mark.

■ Enter the values illustrated in the 
screenshot.

■ Click OK.

  

6. To assign characteristics to the next section of 
the shaft, in the Shaft Component Generator 
dialog box, under Sections, click the second 
Section tree row.

  

7. To remove a feature:

■ Click the arrow for First Edge Features.
■ Select No Feature.

  

8. To size the cylinder:

■ Click Section Properties.
■ In the Cylinder dialog box, for D, enter 16.
■ For L, enter 30. Click OK.

  

9. To add a transition radius for this section:

■ In the feature row, click Second Edge 
Features.

■ Click Fillet.
■ In the Fillet dialog box, under Radius, 

enter 1. Click the check mark.
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10. In the Shaft Component Generator dialog 
box, under Sections, click the third Section 
tree row.

  

11. To change the shaft component to a cylinder:

■ Click the down arrow for Section type.
■ Click Cylinder.
■ Click Yes.

12. To access the cylinder values:

■ Click Section Properties.
■ In the Cylinder dialog box, under 

Dimensions, for Size, next to L, 
enter 30 mm.

  

13. To define the cylinder diameter using other 
parts:

■ In the Cylinder dialog box, under 
Dimensions, for Size, next to D, click 
100.00 mm.

■ Click the arrow. Click Measure.
■ Click the inside diameter of the bearing in 

the bearing mount.
■ Click OK.

  

14. To add a retaining ring groove to this section:

■ Click Section Features.
■ Click Add Retaining Ring.

  

15. To define the features of the retaining ring:

■ Click Feature Properties.
■ In the Retaining Ring Groove dialog box, 

click Custom.
■ Under Dimensions, enter the values for x, 

M and D1 as illustrated.
■ Click OK.

  

16. To create a cylinder section, In the Shaft 
Component Generator dialog box, under 
Sections, click the fourth Section tree row.
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17. To size the diameter of the shaft section:

■ In the graphics area, click one of the grips 
along the diameter of the highlighted 
shaft section.

■ Drag the grip until the value displays 12.

  

18. To size the length of the shaft section:

■ Select the double arrow grip at the end of 
the cylinder.

■ Drag the grip until the value displays 80.

  

19. To add a keyway groove to this section:

■ Click Section Features.
■ Click Add Keyway Groove.

  

20. To locate and define the keyway features:

■ Click Feature Properties.
■ Under Position, select Measure from 

first edge.
■ Set the values for the identified 

properties.
■ Click OK.

  

21. To place the shaft in the assembly:

■ In the Shaft Component Generator dialog 
box, click OK.

■ In the File Naming dialog box, click OK.
■ Click in the graphics window to place the 

shaft.
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Edit a Parametric Shaft

In this section of the exercise, you edit the shaft using 
the same Shaft Component Generator dialog box 
you used to create the shaft.

1. To edit the shaft:

■ Right-click the shaft.
■ Click Edit Using Design Accelerator.

  

2. To add an additional Section tree row to the 
cylinder, in the Shaft Component Generator 
dialog box, under Sections, click Insert 
Cylinder.

  

3. Notice that the new Section tree row is 
inserted below the previously highlighted 
segment (1), and shares the size values (2).

  

4. To relocate the section tree row, click and 
drag the new section to the next to last 
Section tree row in the list. The section tree 
row is relocated below the target section 
tree row.

  

5. To edit the new section tree:

■ Highlight the segment. Click Section 
Properties.

■ In the Cylinder dialog box, for D, enter 14. 
For L, enter 15.

■ Click OK.
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6. To add internal sections to the shaft:

■ In the Shaft Component Generator dialog 
box, under Sections, click the down 
arrow.

■ Click Bore on the Right.

  

7. To insert a Bore section, under Sections, click 
Insert Cylindrical Bore.

  

8. To define the size of the bore:

■ Click Feature Properties.
■ In the Cylinder dialog box, under 

Dimensions, for D, enter 8.
■ For L, enter 10. Click OK.

  

9. To save this shaft for future use:

■ In the Shaft Generator dialog box, click 
More Options (1).

■ Under Templates Library, click Add.
■ For Template Description, enter Shaft 1.
■ Click OK.

  

10. In the Shaft Generator dialog box, click OK.

  

11. Save and close all files.
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Lesson:  Bearing Generator

Overview

This lesson describes the creation and editing of bearings by using the bearing generator in 
Design Accelerator. 

Bearings are used to carry loads in radial and axial directions relative to a rotating part for the purpose 
of reducing friction between the moving parts. By reducing the friction, the amount of force required 
to rotate the parts is less, and the life of the parts is greater. Identifying the roller or ball bearing that 
meets the size requirements of your design, while also meeting the use requirements for the loads, 
can be a time-consuming task. Being able to use the bearing generator in Design Accelerator means 
you can quickly identify and validate which roller or ball bearing to use.

In the following illustration, a section view of an assembly shows the use of a bearing between the 
overhead wheel and axle. 

Objectives

After completing this lesson, you will be able to:

■ Describe the benefits of generated bearings and list the types of bearings that can be generated.
■ State the options available for creating and editing the different generated bearings.
■ Add bearings to your assembly design using the bearing generator. 
■ Edit generated bearings using the bearing generator. 
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About Generated Bearings

With the bearing generator, you can save time and focus on the requirements of your design because 
the generator validates the selection of a bearing and adds the associated 3D content to your 
assembly design. Before you create generated bearings, you should first understand what generated 
bearings are, where they come from, and the benefits of generating bearings. 

In the following illustration, two examples of the two types of generated bearings are shown. A ball 
bearing is shown on the left, and a roller bearing is shown on the right. 

Definition of Generated Bearings

Generated bearings are roller or ball bearings that are added to your assembly design using the 
Design Accelerator tool Bearing Generator. The bearings that are generated come from the Content 
Center. While you can add the same bearings to your assembly by using the Place from Content Center 
tool, adding the bearings using the bearing generator enables you to search for bearings that meet 
specific size criteria, and to conduct calculations to ensure that the bearing you select meets or 
exceeds the requirements of your design.

Because the bearings that are generated originate from the Content Center, you must have access to 
the Content Center. The available standards and bearing content is dependent on what content has 
been installed and which Content Center libraries you are configured to access. The bearing content 
comes from the active Content Center content to ensure that the most current and valid bearing 
versions are selected for use.

When you conduct engineering calculations for a generated bearing, the values you selected and 
entered for the bearing are stored as part of the bearing. Because the values are stored as part of the 
generated bearing, you can review your results or revise your calculations at a later time.

  

The Bearing Generator tool searches for, calculates, and generates only roller and ball 
bearings. If your design requires plain bearings, you can use the Plain Bearing Calculator (SI 
units) to calculate the characteristics of the plain bearing and then add plain bearings to your 
design from the Content Center.
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Example of Generated Bearings

The following illustration shows three different bearings on a shaft. Bearings (1) and (3) are ball 
bearings, which can be generated using the bearing generator. Bearing (2) is a plain bearing and is the 
type of bearing that cannot be generated using the bearing generator.

Bearing (1) was added to the assembly using the bearing generator, and bearing (3) was added by 
placing it directly from the Content Center. While bearings (1) and (3) appear the same in the graphics 
window, they appear differently in the browser and have different information stored with them. 
Following Design Accelerator configuration, the actual bearing part for the generated bearing is in a 
bearing subassembly component. This subassembly stores the bearing part and the calculation 
information related to the bearing.

Bearing Generator Options

When you generate a new bearing or edit an existing generated bearing, you interact with the Bearing 
Generator dialog box. To locate the proper bearing and achieve the creation or editing results you 
require, you need to know what options are available in the dialog box and where they are located. 

Bearing Generator Dialog Box

The Bearing Generator dialog box is displayed after you click the tool to generate a bearing, and after 
you click to edit an existing generated bearing. Within this dialog box you can specify the search 
criteria for a specific sized bearing or range of sizes, select the type of bearing you want to search for, 
select the insertion location for the bearing while defining its inside diameter criteria, and conduct 
calculations on a bearing from the list of found bearings to ensure it meets or exceeds your 
requirements for use.
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  The initially active tab when generating a new bearing or editing an existing generated 
bearing. Use the options on this tab to locate and generate the required bearing.  

  Activate to conduct validation calculations on a bearing in the search results list to ensure it 
meets or exceeds the requirements for use. 

  Click to connect to the Content Center and select what standard, bearing category, and 
bearing type to search through for a match. 

  Use to select part geometry in the assembly to define the inner diameter of the bearing and 
constrain the bearing’s assembly location. 

  Enter size criteria for the outer diameter of the bearing. Values are not required. Leave the 
fields empty to allow all valid size values to be returned. 

  Enter size criteria for the inner diameter of the bearing. Values are not required. Leave the fields 
empty to allow all valid size values to be returned. 

  Enter size criteria for the width of the bearing. Values are not required. Leave the fields empty 
to allow all valid size values to be returned. 

  Click to update the search results list to list bearings that meet newly added size criteria. 

  The list of bearings from the Content Center category that meet your search criteria. Click a 
listed bearing to conduct calculations or to insert it into the assembly. 

If your assembly design limits the outside diameter of the bearing, and the diameter of the shaft 
is then dependent on the available bearing, when you search for a bearing do not select a 
cylindrical face or enter any filter dimension values for the inside diameter. Enter filter dimension 
values only for the outside diameter. As a result, search results list all possible inside diameter 
values that have the specified outside diameter value. 
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Bearing Standards and Categories

To specify which bearings to search for in the Content Center, you identify which industry standard, 
bearing category, and bearing family you want to search through. To specify these options, you click 
the currently listed category to expand the list. When you click the list, the bearing generator connects 
to the Content Center. The expanded list is displayed as an embedded dialog box within the Bearing 
Generator dialog box, as shown in the following illustration. 

 

  Click the current listed category to expand this list and access the Content Center so you can 
select what standard, category, and bearing family you want to search. 

  Select the industry standard to search. 

  Use to select the bearing category to search. Select to search all ball bearing categories, all 
roller bearing categories, or a specific category of ball bearings or roller bearings.  

  A list of bearing families for the selected standard and category that meet the current entered 
size criteria. Click an individual bearing family to list just that specific type of bearing in the 
search results list, or click the folder for the category to list members from all bearing 
family types. 

To restrict the list of bearing families to only those that have family members that meet your 
size criteria, set the filter dimensions for the bearing’s inside diameter, outside diameter, or 
width prior to selecting the bearing category. 
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Generating Bearings

When using the Design Accelerator Bearing Generator to add a bearing to an assembly design, the 
procedure consists of two key tasks. One task consists of defining the category or type of bearing you 
want to use, and the other task consists of specifying the size criteria for the bearing. The order in 
which you do these tasks within the procedure can vary, depending on the design information you 
currently know and what you are trying to find or determine.

For example, if your design already dictates the size requirements for the bearing, you specify the size 
criteria before you select the type of bearing to insert. However, if you need to determine what sizes 
are available for a specific bearing type that meets specific use criteria, then you want to specify the 
bearing category and type, and search without specifying size criteria.

To generate a bearing that meets your specific design criteria using the Design Accelerator Bearing 
Generator tool, you need to understand the overall procedure for searching and adding generated 
bearings.

In the following illustration, a bearing was generated and added to the assembly that met the defined 
inside and outside diameter size criteria.

Access

 

 

  

Bearing Generator

  

Panel Bar: Design Accelerator

Toolbar: Design Accelerator
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Procedure: Generating Bearings

The following steps give an overview of how to identify the type of bearing you want to add to your 
design, specify where it should go and some of its size criteria, and then select the specific bearing 
to use. 

1. On the Design Accelerator panel bar, click Bearing Generator.

2. In the Bearing Generator dialog box, Design tab, select the category of the bearing type you 
want to insert. Select a single industry standard bearing, or click the folder for that category to 
search all industry standards for matching bearings.

  

3. Click the Cylindrical Face selection button. In the graphics window, select the cylindrical face 
on which the bearing is assembled.

  

4. In the graphics window, specify the position of the bearing on the cylinder by selecting a 
planar face of a part with which the side of the bearing should align. In the Bearing Generator 
dialog box, click Flip if the bearing preview is shown on the wrong side of the flat plane.
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5. In the From and To fields, measure or enter values if you require or want to refine your 
search results.

  

6. Click Update to have the bearing results list update using the specified criteria and values.

  

7. In the bearing results list, click the bearing you want to add to the assembly design.

  

8. Click the Calculation tab to enter the appropriate values to calculate and determine whether 
the bearing fully meets your use requirements in your assembly design.
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Editing Generated Bearings

You can perform three types of tasks to edit a Design Accelerator generated bearing. You can delete 
it, change its assembly position relative to the geometry you selected, and change the type or size of 
the bearing. To accomplish these editing tasks, you need to know the procedure for editing generated 
bearings and where and how to access the editing tool. 

In the following illustration, a design was changed by switching from using ball bearings to 
roller bearings.

9. Click OK to have the selected bearing inserted into the assembly. If the File Naming dialog box 
opens because the Always Prompt for Filename option is selected, enter a new name or 
location for the files, if required. Click OK to complete the insertion of the bearing.

  

If you generate a bearing without selecting a cylindrical face, you need to add assembly 
constraints to the bearing to have it properly positioned in the assembly. 
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Access

You access the tools for editing and deleting Design Accelerator generated bearings from the shortcut 
menu after right-clicking the bearing in the browser or graphics window. After right-clicking the 
bearing, you click Delete Design Accelerator Component to delete it, or you click Edit Using Design 
Accelerator to change its size, type, or assembly position.

After you click Edit Using Design Accelerator, the same Bearing Generator dialog box you used to 
initially generate the bearing opens with the same design and calculation options. In addition to 
changing the size or type of bearing, while editing the bearing you can change its assembly offset 
location by clicking and dragging the arrow grip associated with the bearing preview.  

Procedure: Editing Generated Bearings

The following steps give an overview of editing an existing Design Accelerator generated bearing to 
replace it with a different bearing.

 

1. In the browser or graphics window, right-click the generated bearing you want to edit. Click 
Edit Using Design Accelerator.

2. In the Bearing Generator dialog box on the Design tab, select a different bearing type 
or criteria. 

3. If you changed the dimensional criteria for the bearing search, in the Bearing Generator dialog 
box on the Design tab, click Update. 

4. In the search results list of bearings that meet your design criteria, select the bearing 
you require.

5. Click OK to have the newly selected bearing replace the existing bearing.
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Exercise: Generate and Edit Bearings

In this exercise, you generate bearing designs and 
add them to an assembly design. You also make edits 
to the bearings including changing a bearing 
position, updating a bearing after a shaft design 
change, and changing the type of bearing being 
used in the design. 

NOTE: This exercise assumes the following setup 
conditions:

■ The Inventor DIN Content Center library is 
installed and available for use.

■ The prompt for file names for generated 
components is set to its default setting of always 
prompting for file names.

Generate Bearings in an Assembly

In this section of the exercise, you generate two 
bearings and add them to an assembly design.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of chapters 
and exercises, click Chapter 4: Design 
Accelerators. Click Exercise: Generate 
and Edit Bearings.

1. Open GearBox-A.iam.

  

2. Change the panel bar to the Design 
Accelerator panel bar.

3. On the panel bar, click Bearing Generator.

4. To begin defining a deep groove ball bearing 
to add to the assembly:

■ On the Design tab, click the down arrow 
for the bearings list (1).

■ For Standard, select All.
■ For Category, select Deep Groove Ball 

Bearings.
■ In the pane showing the available 

bearings, click the Deep Groove Ball 
Bearings folder as indicated.
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5. To specify the shaft diameter and position of 
the bearing:

■ In the Bearing Generator dialog box, click 
the Cylindrical Face select button.

■ For the cylindrical face, in the graphics 
window, click the identified face of the 
shaft.

■ For the start plane, click the identified 
planar face.

■ In the Bearing Generator dialog box, click 
Flip to change the insert direction. The 
preview appears as shown.

  

6. In the Bearing Generator dialog box, click 
Update.

  

7. In the list of available bearings, scroll through 
the list to observe the number of bearings 
that matches the inside diameter.

NOTE: Decrease the size of the Family column 
or increase the width of the dialog box to 
view more of the data for each bearing family.

 

8. To begin limiting the list of available bearings 
to those that have an outside diameter equal 
to a specific amount, in the Bearing Generator 
dialog box top To field, click the right arrow. 
Click Measure as shown.

  

9. In the graphics window, click the cylindrical 
face as shown.
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10. To update the bearing list now that a distance 
of 52.000 mm is listed in the To field, in the 
Bearing Generator dialog box, click Update.

  

11. To begin inserting the bearing into the 
assembly:

■ In the list of bearings, scroll down and 
select the bearing family DIN 625 as 
shown.

■ Click OK.

  

12. In the File Naming dialog box:

■ Clear the Always Prompt for Filename 
check box.

■ Click OK.

  

13. In the browser and graphics window, review 
the results of the bearing you generated.

  

14. To begin adding another bearing based on 
different criteria:

■ On the panel bar, click Bearing Generator.
■ In the Bearing Generator dialog box, 

Design tab, click the down arrow for the 
bearings list.

■ In the Standard list, select DIN.
■ Click the angular contact ball bearing 

DIN 615 as shown.
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Generate Different Bearings 
in an Assembly

In this section of the exercise, you generate bearings 
using different criteria and add them to an assembly 
design.

15. To specify the shaft diameter and position of 
the bearing:

■ In the Bearing Generator dialog box, click 
the Cylindrical Face select button.

■ For the cylindrical face, in the graphics 
window, click the identified face on the 
other shaft.

■ For the start plane, click the identified 
planar face.

■ In the Bearing Generator dialog box, click 
Flip to change the insert direction. The 
preview appears as shown.

  

16. To specify the outer diameter of the bearing:

■ In the top To field, click the right arrow 
and click Measure.

■ Click the cylindrical face as shown.

  

17. To update the list of selectable bearings and 
insert a bearing:

■ In the Bearing Generator dialog box, click 
Update.

■ In the list of bearings, select the bearing 
family L 25.

■ Click OK. The bearing appears on the 
shaft as shown.

  

1. To begin adding a third bearing using a 
different order of selecting criteria:

■ On the panel bar, click Bearing Generator.
■ In the Bearing Generator dialog box, click 

the Cylindrical Face select button.
■ For the cylindrical face, in the graphics 

window, click the identified face on the 
first selected shaft.

■ For the start plane, click the identified 
planar face.
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2. To specify the outer diameter of the bearing:

■ In the top To field, click the right arrow 
and click Measure.

■ Click the cylindrical face as shown.

  

3. To begin setting the search criteria for needle 
roller bearings in the DIN standard:

■ In the Bearing Generator dialog box, click 
the down arrow for the bearings list.

■ For Category, select Needle Roller 
Bearings.

 

4. In the list of DIN needle roller bearings, click 
DIN 618 - T1 HK.

  

5. To review calculation data for one of the 
bearings:

■ Click the Calculation tab.
■ In the bearing list, click HK3016.
■ Click Calculate.
■ Review the calculation results message 

indicating failure using these default 
values.
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6. To review calculation data for the first listed 
bearing:

■ In the bearing list, click HK3012.
■ Click Calculate.
■ Review the calculation results message 

indicating success.

Reminder: Results of design compliance or 
failure are relevant only if the values used in 
the calculation are truly pertinent to the 
design requirements.

  

7. In the Bearing Generator dialog box, click 
File Naming.

  

8. In the File Naming dialog box:

■ Select the Always Prompt for Filename 
check box to turn on file prompting again 
for components generated after this one.

■ Click OK.

  

9. In the Bearing Generator, click OK. The 
bearing appears on the shaft as shown.

  

10. In the browser and graphics window, review 
the bearings that you have generated.
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Edit Bearings

In this section of the exercise, you edit two of the 
bearings you previously generated.

1. To change the offset position of the needle 
roller bearing:

■ In the browser, right-click Bearing:3. Click 
Edit Using Design Accelerator.

■ In the graphics window, click and drag 
the arrow grip to the upper right to the 
approximate value shown.

  

2. In the Bearing Generator dialog box, click OK. 
The bearing is now positioned as shown.

  

3. To begin changing the diameter of the shaft 
where the first bearing was inserted, in the 
graphics window, right-click the identified 
shaft. Click Edit Using Design Accelerator.

  

4. In the Shaft Component Generator dialog 
box, Sections area, double-click the last 
section Cylinder 20 x 17.8.

5. In the Cylinder dialog box:

■ In the Size cell for dimension D, 
enter 25 mm.

■ Click OK.

  

6. In the Shaft Component Generator dialog 
box, click OK. In the browser, review the 
status of the first bearing. Notice that it 
indicates that it requires updating.
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7. To edit and update the bearing on that 
shaft end:

■ In the graphics window, right-click 
Bearing:1. Click Edit Using Design 
Accelerator.

■ In the Bearing Generator dialog box, click 
Update.

■ In the list of found bearings, click the 
family name DIN 625.

■ Click OK.

  

8. To begin changing the style of roller bearing 
for that first bearing, in the graphics window, 
right-click Bearing:1. Click Edit Using Design 
Accelerator. 

9. In the Bearing Generator dialog box:

■ Click the down arrow for the bearings list.
■ In the Category list, click Four Point 

Contact Ball Bearings.

  

10. In the list of DIN four point contact ball 
bearings, click DIN 628 - T4.

  

11. In the list of found bearings, select QJ205. 
Click OK.

  

12. Review the changes to the bearing.

  

13. Save and close all files.
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Lesson:  Gear Generators

Overview

This lesson describes the creation and editing of spur, bevel, and worm gear sets in Design 
Accelerator. Design Accelerator contains a specific gear generator for each type of gear. 

Gears are components that determine the speed, torque, and direction of power as it is transferred 
through a system. Properly designed gears transmit power smoothly and efficiently, thus reducing 
wear and impact on the system. By changing gear ratios, you can run machinery at optimum efficiency 
and adjust to changing conditions. Using Design Accelerator, you can identify multiple gear 
combinations, and validate their capabilities within your design.

In the following illustration, spur gears are generated to complete a planetary gear system.

Objectives

After completing this lesson, you will be able to:

■ Describe the different types of gears and the benefits of using gear generators.
■ State the options available for creating and editing the different generated gears. 
■ Generate different sets of gears using the appropriate gear generator. 
■ Edit generated gears using the appropriate Design Accelerator generator. 
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About Generating Gears

The gear generators in Design Accelerator enable you to add gear models to your designs by entering 
data in a table format, and then validating your entries prior to producing the gear set. The gear 
generators automate the gear design process and reduce the time required to sketch and model 
gear data.

The gear generators are designed so that you can add general information regarding the type of gear 
set selected and then provide data for the individual gears. At any time during this process, you can 
calculate the current data, preview the gear set in the graphics window, and review the calculations 
for possible issues.  

In the following illustration, the loads applied to a gear set are reviewed.

Definition of Generated Gears

The gear generators are the conduit for entering gear data to produce gear models in your assemblies. 
After the required data is entered into the gear generator, the data is processed and models are 
produced based on the data provided. You do not need access to the Content Center to create 
gear sets.

The data that you input into the gear generators and the resulting calculations are stored with the 
gear set. Because the values are stored as part of the generated gear set, you can review your results 
or revise your calculations at a later time. In addition, you can export the data that you input and the 
calculated data to an ACSII text file to review or share with colleagues.
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Example: Generated Gears

In the following illustration, a bevel gear set is created to change the direction and transmit power 
from the input shaft to the threaded rod. Now that the gear design has been finalized, the final shaft 
lengths can be determined, as well as the methods to secure the gears to the shafts.

Gear Generator Options

When you create or edit gear sets, you interact with the Gears Component Generator dialog box for 
the type of gear specified. The Design Accelerator enables you to efficiently design spur, bevel, and 
worm gear sets. To design and position your gear sets in your assemblies, you need to know what 
options are available in the dialog box and where they are located.
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The specific Gears Component Generator dialog box displays after you click the tool to generate gears. 
Within this dialog box, you enter the method and values required to calculate the required gear set. 
The information required varies depending on the method used.

Each of the gear component generator dialog boxes is divided into three main areas. In the Common 
area, you can specify the gear creation method and other information pertaining to the overall gear 
set. In the Gear1 and Gear2 areas, you can specify data that is specific to the individual gear. For 
example, for a bevel gear set, when you define the Cylindrical Face and Start Plane for each gear, the 
Shaft Angle is calculated and displayed in the Common area.

In the following illustration, each of the gear generator dialog boxes is visible. Each gear generator has 
Design and Calculation tabs where you design and evaluate gear sets. 

Spur Gear Options

The following options are available for creating spur gear sets. 
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Bevel Gear Options

The following options are available for creating bevel gear sets.

  Use to enter data to design the gear set.

  Use to input power and speed requirements and review calculation results. Calculations are 
based on power and speed inputs, and information from the Design tab.

  Use to specify information that applies to the entire gear set.

  Use to input data specific to the first gear.

  Use to input data specific to the second gear.

 

  Use to enter data to design the gear set.

  Use to input power and speed requirements and review calculation results. Calculations are 
based on power and speed inputs, and information from the Design tab.

  Use to specify information that applies to the entire gear set.

  Use to input data specific to the first gear.

  Use to input data specific to the second gear.
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Worm Gear Options

The following options are available for creating worm gear sets.

Common Gear Generator Options

The following options are available when creating gears. For each gear generator, you can perform 
tasks that enable you to streamline your design process. Each of the options shown on the left of the 
following illustration is available when the Design tab of the Gear Component Generator is active. 
When the Calculation tab is active, the options are limited to those shown on the right of the 
illustration.

 

  Use to enter data to design the gear set.

  Use to input power and speed requirements and review calculation results. Calculations are 
based on power and speed inputs, and information from the Design tab.

  Use to specify information that applies to the entire gear set.

  Use to input data specific to the worm.

  Use to input data specific to the worm gear.

  
Design Tab Calculation Tab

  Use to import templates. Templates can be CAL or XML format.

  Use to export templates in XML format.

  Use to redefine display name and file name for components and display name for features.

  Use to Enable/Disable Calculations.

  Use to display an HTML calculation report in a new window.
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Data Transfer to Dynamic Simulation Environment

Data created by the Gear Generator can be transferred to the Dynamic Simulation environment.

Dynamic Simulation—Rolling Joints

Gear sets created using the Design Accelerator transfer into the Dynamic Simulation environment as 
rolling joints. When you enter the Dynamic Simulation environment, each rolling joint will be 
displayed in the Browser. If you hover the cursor over the rolling joint in the Browser, vectors will 
display in the graphics area.

Creating Gears

When using Design Accelerator to add gears to your assemblies, the procedure that you use is 
dependent on the gear type selected and the input data available to you. The dialog box for each gear 
type contains Design and Calculation tabs. On the Design tab, a Common area exists to input data 
pertaining to the gears. Depending on the method selected, the data in the dialog box may be entered 
manually, or it may be calculated from other input data.

In the following illustration, a spur gear set is added to the assembly. In the Common area of the Spur 
Gears Component Generator dialog box, the Desired Gear Ratio is calculated from the number of gear 
teeth input for each gear, and the Center Distance is obtained from the selection of the shaft in the 
graphics window.
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Access

 

  

Spur Gears Generator

  

Panel Bar: Design Accelerator

Toolbar: Design Accelerator

  

Bevel Gears Generator

  

Panel Bar: Design Accelerator

Toolbar: Design Accelerator

  

Worm Gears Generator

  

Panel Bar: Design Accelerator

Toolbar: Design Accelerator
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Procedure: Creating Gears

The following steps describe creating gear sets. In this example, the Spur Gears Component Generator 
illustrates the procedure. However, the steps involved are similar for all three gear types.

1. Start the Gear Component Generator. 

  

2. On the Design tab, Common area, enter and 
select defining values that are common to 
both gears.

  

3. Define the first gear by selecting sizes and 
existing geometry for position if geometry 
already exists in the assembly. 

  

4. Define the second gear.
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Editing Gears

You can edit gear sets created with Design Accelerator with the same tools used to create the gear 
sets. You can edit the size and location of either gear. Depending on the type of gear, you can also 
change gear ratios, face width, or pressure angles to test additional gear options. To accomplish these 
editing tasks, you need to know the procedure for editing generated gears and where and how to 
access the editing tool. 

In the following illustration, the gear ratio was changed to spin the driven gear faster. After editing the 
gears, gear calculations were reviewed to ensure a sound design.

Access

You access the tools for editing and deleting Design Accelerator gear sets from the shortcut menu 
after right-clicking the gear set in the browser or graphics window. After right-clicking the gear set, 
you click Delete Design Accelerator Component to delete it, or you click Edit Using Design Accelerator 
to change its size, type, or assembly position.

After you click Edit Using Design Accelerator, the same gear generator dialog box that you used to 
initially create the gear set opens with the same design and calculation options. In addition to 
changing the size or ratio of the gear set, while editing the gear set you can change its assembly 
location by specifying a new cylindrical face and start plane.

5. Generate the gears.
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3D Grips on Gear Sets

3D Grips are enabled on gear sets generated using the Design Accelerators Gear Component 
Generators. Depending on the specifications and type of gear, 3D Grips will display to define the 
facewidth or diameter of the gears. 
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Procedure: Editing Gears

The following steps describe editing gears using Design Accelerator.

1. In the browser or graphics window, right-click 
a gear in the gear set and click Edit Using 
Design Accelerator.

  

2. Make the changes to the gear set as needed.

  

3. Click OK to update the gear set.
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Editing Gears Using 3D Grips

The following steps describe editing gears using 3D Grips to define facewidth. You can use 3D Grips 
during the creation or editing of gearsets.

1. In the browser or graphics window, right-click 
a gear in the gear set and click Edit Using 
Design Accelerator.

  

2. Drag the 3D Grip to the desired facewidth.

  

3. Click OK to update the gear set.
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Exercise: Generate and Edit Gears

In this exercise, you create spur and bevel gear sets. 
You edit the gears to provide clearance for the shafts. 

Create Spur Gears

In this section of the exercise, you add a spur gear set 
to an assembly.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of chapters 
and exercises, click Chapter 4: Design 
Accelerators. Click Exercise: Generate 
and Edit Gears.

1. Open Bead_Roller.iam.

  

2. Rotate the view so you can see the handle 
area.

  

3. To access Design Accelerator:

■ On the Assembly Panel, click Assembly 
Panel.

■ Click Design Accelerator.

  

4. To begin to add spur gears to your assembly, 
on the Design Accelerator panel bar, click 
Spur Gear Generator.
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5. To set the Common values for the spur gear:

■ In the Spur Gear Component Generator 
dialog box, under Common, for Design 
Guide, click Number of Teeth.

■ For Desired Gear Ratio, click 1.0000 ul.
■ For Module, click 2.000 mm.
■ For Helix Angle, enter 0.
■ Verify that Internal is not selected.

  

6. To define the values for Gear 1:

■ In the Spur Gear Component Generator 
dialog box, under Gear 1, click Cylindrical 
Face. Click the shaft near the handle (1).

■ Click Start Plane. Click the bushing 
face (2).

■ Drag the 3D Grip (3) to a value of 25.

  

7. To define the values for Gear 2:

■ In the Spur Gear Component Generator 
dialog box, under Gear 2, click Cylindrical 
Face. Click the lower shaft (1).

■ Click Start Plane. Click the bushing 
face (2).

■ For Facewidth, enter 25.

Notice that under Common the Center 
Distance has updated.

  

8. To check your design, in the Spur Gears 
Component Generator, click Calculate.
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Create and Edit Bevel Gears

In this section of the exercise, you create and edit a 
bevel gear set.

9. To add the gears to your assembly, click OK. In 
the File Naming dialog box, click OK.

  

1. Rotate the view to see behind the rollers. 
Adjust view on the area indicated (1).

  

2. To begin to add bevel gears to your assembly, 
on the Design Accelerator panel bar, click the 
Spur Gear flyout. Click Bevel Gear Generator.

  

3. To set the Common values for the bevel gears:

■ In the Bevel Gears Component Generator 
dialog box, under Common, for 
Facewidth, enter 4. 

■ For Module, select 1.125 mm.

  

4. To define the values for Gear 1:

■ In the Bevel Gear Component Generator 
dialog box, under Gear 1, for Number of 
Teeth, enter 16.

■ Click Cylindrical Face. Click the shaft as 
indicated (1).

■ Click Start Plane. Click the face as 
indicated (2).
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5. To define the values for Gear 2:

■ In the Bevel Gear Component Generator 
dialog box, under Gear 2, for Number of 
Teeth, enter 16.

■ Click Cylindrical Face. Click the mounting 
shaft as indicated (1).

■ Click Start Plane. Click the washer face as 
indicated (2).

  

6. To check your design, in the Bevel Gears 
Component Generator, click Calculate.

  

7. To review the gear calculation message:

■ In the Bevel Gears Component Generator 
dialog box, notice the red lines displayed 
after performing the calculation.

■ Click the chevrons to display the 
message.

 

8. To view the calculation results:

■ In the Bevel Gears Component Generator, 
click the Calculation tab.

■ Review the results.

  

9. This gear set will be driven by hand. To 
change the loads on the bevel gears:

■ In the Bevel Gears Component Generator, 
Calculation tab, under Loads, for Power, 
enter .001 kW.

■ For Speed, enter 40 rpm.
■ Click Calculate.
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10. Review the results:

  

11. To add the gears to your design, in the Bevel 
Gears Component Generator dialog box, click 
OK. In the File Naming dialog box, click OK.

  

12. To edit the bevel gear set:

■ In the browser or graphics window, select 
the gears.

■ Right-click. Click Edit Using Design 
Accelerator.

 

13. To change the number of teeth in each gear, 
in the Bevel Gears Component Generator 
dialog box:

■ Under Gear1 enter 17.
■ Under Gear2, enter 17.
■ Click Calculate. Click OK.

  

14. In the browser, expand Bevel Gears:1.
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15. To edit a bevel gear:

■ In the browser, double-click Bevel 
Gear1:1.

■ On the Inventor Standard toolbar, click 
Sketch. Click the face of the bevel gear.

■ Project the outer diameter of the shaft to 
the face, and extrude cut the gear.

■ Repeat for Bevel Gear2:1.

  

16. On the Inventor Standard toolbar, click 
Return.

  

17. Save and close all files.
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Lesson:  Belt Generators

Overview

This lesson describes the creation and editing of belt drive systems using the belt generators in 
Design Accelerator. 

Power transmission systems for V-belt drives, synchronous belt drives, and chain drives can be a 
critical aspect of some machine designs. Spending project time locating and modeling the available 
sizes of pulleys or sprockets, and belts or chains, so that they can be added to your designs is not an 
efficient use of your design time. Learning to use a Design Accelerator tool like the V-Belts Generator, 
Synchronous Belt Generator, or Chain Generator is beneficial to your productivity. Using these tools 
enables you to focus on the functional aspects of your design.

In the following illustration, the belt drive system for transferring the rotating power of the stepper 
motor to the shaft was initially created, positioned, and checked for accuracy using a single tool 
focused on creating functional designs.

Objectives

After completing this lesson, you will be able to:

■ Describe the benefits of generated belt designs and list the types of belt designs that 
can be generated.

■ State the options available for creating and editing generated belt designs. 
■ Add belt designs to your assembly design.
■ Edit generated belt designs.
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About Generated Belt Drive Systems

Creating belt drive systems by using an appropriate Design Accelerator tool helps you create a design 
that uses industry-standard parts and meets your design criteria for its use. By ensuring that your 
design meets the requirements for its use, or improving on its current design, you can create a better 
product that much more quickly. To achieve these benefits and others, you must learn what a 
generated belt design is and the types of belt designs that you can generate. 

In the following illustration, the calculation results are shown for a V-belt configuration that is in the 
process of being designed. Based on these results, changes to the design or expectations of the design 
can be corrected during this stage of the overall design process.

Definition of Generated Belt Drive Systems

A belt drive system is a mechanical system used to transmit rotational power from one location to 
another through the use of pulleys on shafts and belts around the pulleys. The belts are either V-belts 
or synchronous belts. Pulleys for the drive system can be flat, V-grooved, or pulleys with teeth. A 
generated belt drive system is one that has the pulleys and belts automatically created based on the 
values and options that you select and enter. You use the V-Belts Generator or Synchronous Belts 
Component Generator tool to generate a belt drive system consisting of components that meet your 
design criteria.
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In the following illustration, a section of a V-belt and synchronous belt drive system is shown 
with a representative pulley and belt. The V-belt design is shown on the left and synchronous belt 
on the right.

During the process of defining a belt-driven power transmission system, you must position and size 
the pulleys. For cost purposes, you want to select only standard sizes for the pulleys and the belt 
lengths. These two factors then play a significant role in determining which sizes pulleys you can 
select and the possible positions of nonfixed pulleys. By generating a belt drive system using the 
Design Accelerator generator for V-belts or synchronous belts, not only does the tool help you create 
geometry that meets your design criteria, it also helps you work with the geometry in an efficient and 
streamlined manner.

You are efficient in creating your designs because you directly select common standard pulley sizes, 
and the calculated belt lengths automatically calculate and match available industry sizes. While 
generating a new design or editing an existing design, you can click and drag through the available 
sizes and positions in the graphics window, which helps you to efficiently set the size or position and 
visualize the results of that selection. Generating the belt drive system does not require time spent 
creating combinations of design components, or validating the selection of components through 
manual calculation. The design process is therefore streamlined.

When you generate a power transmission design of belts, chains, or gears, motion constraints are 
automatically applied to related gears, sprockets, and pulleys. By turning on the Flexible option for 
their design and adding constraints to other parts, you can quickly observe their kinematics and how 
this impacts the rest of the design.

In the following illustration, a pulley defined to slide in an allowable direction is being dragged to a 
new location. Even though the pulley is free to slide, its possible positions are being defined by the 
different available belt lengths.
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Data for the Generators

The values and geometry used by the generators come from different locations depending on 
whether the generator is retrieving the initial default configuration, the last configuration you created, 
the defined industry standards and values, or the model geometry. The following table identifies the 
type of information that can be retrieved and the default folder paths where you go to review 
that data.

Example of a V-Belt Power Transmission Design

In the following illustration, a pulley and belt power transmission system is in the process of being 
created. For something that appears to be very simple to design, a pulley and belt power transmission 
system has multiple issues and criteria to consider.

On the most basic level, you need to decide the type of pulley and belt to use and which standard it is 
based on. Based on these decisions, you have only certain industry sizes available to select and use in 
your assembly. After positioning and sizing the pulleys, the possible belts that fit around the pulleys 
are limited.

If you were designing this manually and a belt length was not available to fit the design, you would 
then need to spend time trying new pulley sizes and positions to get a belt to work, or start the process 
all over again with the selection of a new belt type or size. By using the V-Belts Component Generator, 
all these issues are automatically dealt with as you design the belt power transmission system. With 
those items resolved, you can now check whether the proposed system can handle the power, torque, 
or speed expected for this system.

Data Default Path

Initial Default 
Configuration

[Drive:]\Program Files\Autodesk\Inventor [version]\Design Accelerator\ 
Defaults

Default User-Defined 
Configuration

[Drive:]\Documents and Settings\[User name]\Application Data\Autodesk\
Inventor [version]\DesignAccelerator\Defaults

Defined Industry 
Standards and Values

[Drive:]\Program Files\Autodesk\Inventor [version]\Design Data\
Design Accelerator\Tables

Master Model Geometry [Drive:]\Program Files\Autodesk\Inventor [version]\Design Accelerator\Models
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Belt Generator Options

When you generate a new belt power transmission design or edit an existing one, you interact with 
either the V-Belts Component Generator dialog box or Synchronous Belts Component Generator 
dialog box, depending on the type of belt design that you are creating or editing. To achieve the 
creation or editing results you require, you need to know what general options are available in the 
dialog box and where they are located.  

V-Belts Component Generator Dialog Box

The V-Belts Component Generator dialog box is displayed after you click the tool to generate a V-belt 
design and after you click to edit an existing generated design. The layout of options in this dialog box 
is identical to that in the Synchronous Belts Component Generator dialog box. The only difference is 
the pulley and belt types that are specific to that design.

Within this dialog box you specify the type of belt, how many belts, and their positions in the 
assembly. You also add and remove pulleys from the design and specify the properties of the pulleys. 
The pulley properties include type, size, and location in the assembly.

 

  The initially active tab when generating a new belt design or editing an existing generated belt 
design. Use the options on this tab to define the configuration of belts and pulleys and 
generate the geometry in the assembly.  

  Activate to conduct validation calculations on the current belt design to ensure that it meets 
or exceeds the requirements for use. 

  Use the options in this area to select and enter the belt type, its midplane position in the 
assembly, and number of belts. 

  Use the options in this area to add and remove pulleys to the design and set their position, 
type, and size. 

  Expand the dialog box to access the options for toggling the display of the belt coordinate icon 
and toggling the lock for the length of the belt. 
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Pulley Options

Pulleys in a belt design are added, removed, and configured in the Pulleys area of the dialog box. Each 
row of options and information in the list is a pulley within the design. You can reorder the pulleys in 
the list by dragging and dropping them above or below other listed pulleys by clicking a specific 
pulley’s name. 

Creating Belt Drive Systems

To create a belt-driven power transmission system, you use the Design Accelerator tools V-Belts 
Generator or Synchronous Belts Component Generator. Both of these tools create an assembly 
composed of pulleys and belts. To use these tools to generate a belt drive system, you need to know 
where to access the tools and the procedure to follow for their use.

 

  Set to have a new pulley component created, select an existing pulley in the assembly, or have 
a virtual pulley used in the generated design.

  Select the type of placement condition to use for the pulley. Pulleys are either fixed in position 
or allowed to slide with or without restrictions. 

  Activate to select geometry to define the position of the pulley when using the placement 
options Fixed Position by Selected Geometry, Controlled Sliding Position, or Rotation Driven 
Sliding Position. 

  Use to access the Pulley Properties dialog box to change properties of the pulley.

  Use to select the type of pulley for the selected belt type. 

  Click to add additional pulleys to the belt design. 

You can change the size and position properties of a pulley by grip editing the preview of the 
pulley in the graphics window. 
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Access

Access

Procedure: Creating Belt Drive Systems

The following steps give an overview of creating a belt drive system by using Design Accelerator tools 
to generate the design.  

  

V-Belts Generator

  

Panel Bar: Design Accelerator

Toolbar: Design Accelerator

  

Synchronous Belts Component Generator

  

Panel Bar: Design Accelerator

Toolbar: Design Accelerator

1. On the Design Accelerator panel bar, click the required belt generator tool. 

2. In the graphics window, click the work plane or part planar face to establish the alignment and 
reference location for the midplane of the belt drive system.

  

3. In the dialog box, select the type of belt, number of belts, and enter the midplane offset.

4. Set the properties and position of the first pulley which is the driving pulley.
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5. Set the properties and position of the second pulley.

  

6. Add or remove pulleys from the list and set the properties and positions of any additional 
pulleys. Reorder the pulleys in the list to change their order and positions in the design.

  

7. Click the Calculation tab to enter the appropriate values to calculate and determine whether 
the configured belt design fully meets your use requirements in your assembly design. 

8. Click OK to have the configured belt drive system inserted into the assembly. If the File Naming 
dialog box opens because the Always Prompt for Filename option is selected, enter a new 
name or location for the files, if required. Click OK to complete the insertion of the belt drive.

  

The first pulley in a generated belt drive system is always the driving pulley. 
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Procedure: Changing Synchronous Belt Display

The following steps describe changing the display of a synchronous belt.

1. Create a synchronous belt, or right-click and 
click Edit Using Design Accelerator.

  

2. Expand the Synchronous Belts Component 
Generator dialog box. Under Belt Options, 
select Sketch.

  

3. The synchronous belt is now displayed as a 
sketch.
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Editing Belt Drive Systems

After you have generated a belt drive system, you have two possible editing tasks. You can delete the 
entire generated design, or you can change different aspects of the design. The types of changes to 
the design can include but are not limited to changing the location where a pulley resides in a design 
by changing its order in the design, changing pulley sizes, adding or removing individual pulleys, 
changing the type of belt used, reviewing previous calculations, and recalculating using new 
requirement values. To accomplish these editing tasks, you need to know the procedure for editing 
generated belt designs and where and how to access the editing tools. 

In the following illustration, the initial belt drive system had multiple aspects of its design changed. 
The flat tensioner pulley changed to a V-groove pulley, the driving direction of the belt was reversed, 
and all the pulleys had their diameters changed. 

Access

You access the tools for editing and deleting Design Accelerator generated belt designs from the 
shortcut menu after right-clicking the belt design in the browser or graphics window. After right-
clicking the belt design, you click Delete Design Accelerator Component to delete it, or you click 
Edit Using Design Accelerator to change the type of belt, or the size and position of the pulleys, or to 
add and remove pulleys. 

4. Select the Detailed option to display the 
synchronous belt with all the teeth.
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After you click Edit Using Design Accelerator, the same generator dialog box that you used to initially 
create the belt design opens with the same design and calculation options.

Procedure: Editing Belt Drive Systems

The following steps give an overview of editing an existing Design Accelerator generated belt design 
to change design properties and sizes.

 

1. In the browser or graphics window, right-click the generated belt design you want to edit. Click 
Edit Using Design Accelerator. 

2. Make the required changes in the graphics window or on the Design tab in the dialog box for 
that belt generator.

3. Click OK to generate the revised belt design. 
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Exercise: Generate and Edit Belt Drive Systems

In this exercise, you create a power transmission 
system consisting of three pulleys and a belt. While 
generating the design, you set the position and size 
of the pulleys and you calculate the power based on 
force and speed. You then modify the design by 
adding a motion constraint and setting it flexible, as 
well as changing the type of one pulley and the size 
of all three pulleys.

Exercise Setup

If a default configuration file for metric belt 
configurations already exists for the currently logged 
in user, delete it.

1. In Windows Explorer, navigate to the following 
path: [Drive:]\Documents and Settings\
[User name]\Application Data\Autodesk\ 
Inventor 2009\DesignAccelerator\Defaults.

2. Select and delete the file CAVBelts.Metric.xml.

Add Pulleys and a V-Belt

In this section of the exercise, you generate a V-belt 
power transmission system by adding three pulleys 
and a V-belt to an assembly design. The belt runs 
from the motor to the shaft and is inserted after 
running a quick calculation on the design.

The completed exercise 

Completing the Exercise
To complete the exercise, follow the 
steps in this book or in the onscreen 
exercise. In the onscreen list of chapters 
and exercises, click Chapter 4: Design 
Accelerators. Click Exercise: Generate 
and Edit Belt Drive Systems.

1. Open Belt Drive System.iam.

  

2. On the Design Accelerator panel bar, click 
V-Belts Generator. 

3. To specify the belt’s midplane location, click 
the visible work plane in the middle of the 
shaft.

  

4. To begin specifying the position of the first 
pulley, under Pulleys, select the Fixed 
Position by Selected Geometry option.
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5. To specify the position, select the shaft of the 
motor.

  

6. To specify the position of the second pulley:

■ Under Pulleys, for the second pulley 
listed, select the Fixed Position by 
Selected Geometry option as you did for 
the first pulley.

■ Select the center shaft section.

  

7. To add another pulley to adjust the tension of 
the belt:

■ Under Pulleys, click the Click to Add 
Pulley bar.

■ Click Grooved Pulley 10/Z.

  

8. From the positioning list, click Direction 
Driven Sliding Position.

  

9. Click the work plane in the center slot of the 
middle bracket.
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10. Resize the pulley located on the long shaft by 
clicking and dragging one of the quadrant 
grips out to increase the size of the pulley to 
140 mm as shown.

  

11. Resize the third pulley by dragging one of the 
quadrant grips out to increase the size of the 
pulley to 160 mm as shown.

  

12. Review the new position of this pulley after 
the diameter was changed. Notice how it was 
automatically moved to a proper position to 
maintain a valid belt length.

 

13. To begin conducting a strength check for the 
current design:

■ On the Calculations tab, under Load, from 
the list click Torque, Speed > Power.

■ For Torque, enter 10.000 N m.

  

14. Click Calculate. Notice the red expansion bars 
for the summary and results window and red 
text indicating and identifying specific issues.
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Edit a Generated V-Belt Design

In this section of the exercise, you make the V-belt 
power transmission system flexible and constrain it 
to observe the kinematics of the assembly. You also 
change the size and type of different pulleys.

15. To calculate a different torque value:

■ Change the Torque value to 1.000 N m.
■ Click Calculate. The results show that the 

calculations indicate design compliance.

  

16. To generate the pulleys and belt 
components:

■ With the pulley and belt preview 
displayed as shown, click OK.

■ In the File Naming dialog box, click OK.

  

17. Review the created components that now are 
displayed as shown.

  

1. To add a rotation motion constraint between 
the long shaft and the pulley on that shaft:

■ On the panel bar, click Constraint.
■ In the Place Constraint dialog box, click 

the Motion tab.
■ Select the cylindrical faces of the shaft 

and pulley as shown.
■ Click OK.

  

2. In the browser or graphics window, right-click 
the V-Belt Transmission component. Click 
Flexible.

3. To begin adding an angular constraint 
between the first pulley and motor bracket to 
put the assembly in motion:

■ On the panel bar, click Constraint.
■ In the Place Constraint dialog box, Type 

area, click the Angle.
■ In the browser under Origin for the first 

grooved pulley, click X Axis.
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4. To finish adding the constraint:

■ In the graphics window, click the top 
edge of the bracket.

■ In the Place Constraints dialog box, 
click OK.

  

5. To begin driving the angle constraint and 
view its effects, in the browser under V-Belt 
Transmission, right-click the angle constraint. 
Click Drive Constraint.

6. In the Drive Constraint dialog box:

■ In the End field, enter 360.
■ Click to play the constraint forward.
■ In the graphics window, view the speed 

at which the shaft is driven by the belt 
transmission system.

  

7. In the Drive Constraint dialog box, click OK.

8. In the browser or graphics window, right-click 
the V-Belt Transmission component. Click 
Edit Using Design Accelerator.

9. To begin changing the diameter of the 
second grooved pulley, in the Pulleys area, 
click Pulley Properties as indicated.

  

10. In the Groove Pulley Properties dialog box:

■ In the Diameter list, click 100.000 mm.
■ Click OK.

  

11. To begin changing the third pulley from a 
grooved pulley to a flat pulley:

■ Click Browse for Pulley Type.
■ In the list of pulley types, click Flat Pulley 

(Metric).

  
312  ■ Chapter 4:  Design Accelerators



12. To change the belt direction over the third 
pulley, in the graphics window, click the 
arcing arrow.

  

13. To decrease the diameter of the third pulley, 
in the graphics window, click and drag one of 
the quadrant grips to a size of 63 mm as 
shown.

  

14. To begin changing the diameter of the first 
grooved pulley, in the graphics window:

■ Position the cursor over one of the 
quadrant sphere grips to have them 
change to arrow grips.

■ Double-click one of the arrow grips.

  

15. In the Groove Pulley Properties dialog box:

■ In the Diameter list, click 125.000 mm.
■ Click OK.

  

16. With the belt drive system preview as shown, 
in the V-Belts Component Generator dialog 
box, click OK.

  

17. In the File Naming dialog box, click OK. The 
assembly now appears as shown.

  

18. Save and close all files. 
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Appendix

A

Additional Support and ResourcesAppendix A:  

A variety of resources are available to help you get the most from Autodesk® software:

■ Courseware from Autodesk (AOTC, AATC)
■ Autodesk Services and Support
■ Autodesk Subscription
■ Autodesk Consulting
■ Autodesk Partners
■ Autodesk Authorized Training Centers (ATC®) 
■ Autodesk Student Community
■ Autodesk Certification
■ Autodesk Store
■ Useful links
483



Courseware from Autodesk

Autodesk publishes dozens of courseware titles every year designed to help users at all levels of 
expertise improve their productivity with Autodesk software.

Courseware from Autodesk is the preferred classroom training material for Autodesk Authorized 
Training Centers (ATC) and Resellers. The same training materials are also well-suited for self-paced, 
standalone learning.

Autodesk offers two brands of Courseware:

Autodesk Official Training Courseware  (AOTC) is developed by Autodesk for hands-on learning 
covering the most important software features and functionality.

Autodesk Authorized Training Courseware  (AATC) is created in cooperation with leading Autodesk 
partners, and includes a growing number of local-language titles.

Experience Real-world, Hands-on Learning

Students simulate real-world projects and work through hands-on, job-related exercises. Most titles 
include a trial version of the software.

Reaching All Levels

Autodesk has courseware titles to fit a wide range of skill levels. Beginners, advanced users, and those 
looking for transitioning and migration materials will find a title that fits their needs:

■ Essentials  titles teach the basics.
■ Transition  titles help smooth the way of upgrades and migrations.
■ Advanced  titles focus on advanced skills to improve productivity.
■ Solution Series  apply a process-based approach to real-world projects. 

Role-specific Learning Paths

Autodesk Courseware fits into a wide range of role-based Learning Paths so you can focus your 
training on skills and certifications that are most important to your job—and career. Within each 
Learning Path, you’ll find a series of courses that follow a natural progression and build on each other, 
delivering a powerful synergy of both theory and practical skills. Like a roadmap, each Learning Path 
provides you with a clear and effective route to your career destination.

To embark on your personal learning path, talk with your local Autodesk Authorized Training Center 
www.autodesk.com/atc. An ATC instructor can lead you through the steps to improve your product 
knowledge and map the way to gaining Autodesk Certification www.autodesk.com/certification.

Available for Most Autodesk Products 

■ AutoCAD® Architecture ■ Autodesk® Vault
■ AutoCAD® MEP ■ AutoCAD®
■ Revit® Architecture ■ AutoCAD LT®
■ Revit® MEP ■ AutoCAD® Raster Design
■ Revit® Structure ■ AutoCAD® Map 3D
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Digital Site Licenses

Delivering training for a large number of students? A Courseware Digital Site License enables you to 
print courseware yourself to flexibly meet your training schedules and enrollment levels. Contact your 
Autodesk Reseller or inquire directly with Autodesk by emailing AOTC.feedback@autodesk.com for 
more information.

Finding Courseware

Courseware can be found in training classes offered by Autodesk Authorized Training Centers, 
Autodesk Resellers, or may be purchased directly from the Autodesk Store (store.autodesk.com).
To find up-to-date information on the latest official Autodesk courseware titles, visit 
www.autodesk.com/aotc and browse the Courseware Catalog for titles and topics.

Feedback Encouraged

If you have comments, suggestions for future titles, or general inquiries about Autodesk courseware, 
please email AOTC.feedback@autodesk.com. We value your feedback!

Autodesk Services & Support

Accelerate return on investment and optimize productivity with innovative purchase methods, 
companion products, consulting services, support, and training from Autodesk and Autodesk 
authorized partners. Designed to get you up to speed and keep you ahead of the competition, these 
tools help you make the most of your software purchase—no matter what industry you’re in. To learn 
more, visit www.autodesk.com/servicesandsupport.

Knowledge Base

Search the support database for answers, hot fixes, tips, and service packs. Access the knowledge base 
from the main Autodesk Services & Support page at www.autodesk.com/servicesandsupport.

Contact a Reseller

Get in touch with a reseller near you for information on product support programs that fit your needs. 
Find a reseller near you with our reseller locator at www.autodesk.com/reseller.

Discussion Groups

Ask questions and share information in peer-to-peer forums. For more information visit the Discussion 
Groups area at www.autodesk.com/discussion.

■ AutoCAD® Civil 3D® ■ Autodesk® MapGuide® Studio
■ AutoCAD® Land Desktop ■ Autodesk® MapGuide® Enterprise
■ AutoCAD® Electrical ■ Autodesk® VIZ
■ AutoCAD® Mechanical ■ Autodesk® 3ds Max®
■ Autodesk® Inventor® 

(not a stand-alone product)

■ Autodesk® Maya®

■ Autodesk® Inventor® Professional ■ Autodesk® NavisWorks®
■ Autodesk® Productstream®
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Autodesk Subscription

Get the benefits of increased productivity, predictable budgeting, and simplified license management 
with Autodesk® Subscription. Customers get the latest release of Autodesk software by electronic 
download or physical shipment, incremental product enhancements, and exclusive license terms that 
are available only to Subscription members. A range of community resources, including web support 
direct from Autodesk technical experts and self-paced training to extend user skills, make Autodesk 
Subscription the best way to optimize the Autodesk software investment.

■ Autodesk Subscription offers a way to make software costs predictable. Whether a customer opts 
for a one-year subscription or a multiyear contract, the costs are known for the entire term of the 
contract.

■ Autodesk Subscription makes managing software licenses easier. Customers have added 
flexibility to allow their employees to use their Subscription software—in the office or at home. 
Better yet, designers are entitled to run previous versions of the software concurrently with the 
latest release under certain conditions.

■ Get what you need to stay productive. With web support you get direct, one-to-one 
communication with Autodesk support technicians for answers to your installation, configuration, 
and troubleshooting questions. Web and email communications deliver support straight to your 
desktop.

■ e-Learning lessons give customers a quick and easy way to learn about the features and 
functionality of most current products and previous versions. Choose from a range of online 
tutorials by logging into Subscription Center or by accessing e-Learning directly from most 
products via the InfoCenter. These short lessons are available on demand and complement more 
in-depth training provided through Autodesk Authorized Training Centers or Autodesk 
Authorized Resellers.

■ For more information visit www.autodesk.com/subscription.

Autodesk Consulting 

Accelerate your return on investment with Autodesk Consulting. Offering a comprehensive range of 
business consulting services, Autodesk Consulting can help you identify your business needs, 
recommend the right Autodesk® and partner products and services, and help you configure and 
implement the optimal solution. For more information please visit www.autodesk.com/consulting. 

Autodesk Partners

Developer Center

The Developer Center was created for software developers seeking proven tools, technologies and 
support to create competitive advantage. Whether you plan to customize Autodesk software for 
internal use or develop a commercial application, Autodesk is committed to giving you the 
information and support you need. For more information visit www.autodesk.com/developer.
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Autodesk Developer Network (ADN)

Members of ADN, commercial software developers, consultants and customers, develop software that 
leverages Autodesk technology creating competitive advantage for their organization. Whether 
developing a simple utility, plug-in, integration or large scale application, ADN membership gives you 
access to direct support from Autodesk software engineers, development software, and the 
marketing tools you need to succeed. For more information visit www.autodesk.com/joinadn.

Reseller Center

Autodesk’s resellers understand your design processes and business requirements, and specialize in 
all kinds of industries and applications. You can maximize your productivity with Autodesk software 
with Reseller services, from implementation and customization to learning and training. To learn more 
and find a reseller near you, visit www.autodesk.com/resellers.

Partner Products & Services 

Autodesk works together with thousands of software development partners from around the world. 
In the Partner Products & Services catalog, you can search for and find detailed information on 
Autodesk partners around the world that further enhance our broad range of fully integrated and 
interoperable solutions, for every design profession you can imagine. For more information visit 
www.autodesk.com/partnerproducts.

Autodesk Authorized Training Centers 

Be more productive with Autodesk Software. Get trained at an Autodesk Authorized Training Center 
(ATC) with hands-on, instructor-led classes to help you get the most from your Autodesk Products. 
Autodesk has a global network of Authorized Training Centers offering Autodesk-approved training 
of the highest quality. Many ATCs offer end-user Certification testing. Locate a testing center near you 
at autodesk.starttest.com.

Every day, thousands of our customers are taught how to realize their ideas, faster, with Autodesk 
software. You can perform smarter and better with Autodesk software products when you turn to an 
Authorized Training Center. ATCs are carefully selected and monitored to ensure you receive high-
quality, results-oriented learning.

An ATC is your best source for Autodesk-authorized classes, tailored to meet the needs and challenges 
facing today’s design professionals. 

Find an Authorized Training Center

With over 2000 ATCs around the world, there is probably one close to you. Visit the ATC locator at 
www.autodesk.com/atc to find an Autodesk Authorized Training Center near you. Look for ATC courses 
offered at www.autodesk.com/atcevents.

Autodesk Student Community

Student Engineering and Design Community Students and Faculty can take advantage of free 
Autodesk software, self-paced tutorials, worldwide discussion groups and forums, job postings, and 
more. Become a member of the Student Community today and be a leader in the next generation of 
design.  www.autodesk.com/edcommunity

NOTE:  Free products are subject to the terms and conditions of the end-user license agreement that 
accompanies download of the software.
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Autodesk Certification 

Gain a competitive edge with Autodesk Certification. Autodesk certifications validate that you have 
the knowledge and skills required to use Autodesk products. Demonstrate your software skills to 
prospective employers, advance your career opportunities, and enhance your credibility. 

Certification Benefits
■ Immediate feedback on your certification status.
■ An Electronic Certificate with a unique serial number.
■ The right to use an official Autodesk Certification logo.
■ The option to display your certification status in the Autodesk Certified Users database.

For more information:

Visit www.autodesk.com/certification to learn more and to take the next steps to get certified. 

Autodesk Store

Autodesk software and numerous training tools are available to buy online at the Autodesk Store.  
Find Courseware, DVDs, User Guides, Getting Started Guides, Handbooks, Tutorials, and more at 
store.autodesk.com.

NOTE:  Autodesk software is available for purchase through the Autodesk Store for users in U.S. and 
Canada only.

Useful Links

Courseware: 
www.autodesk.com/aotc

Consulting: 
www.autodesk.com/consulting

Certification: 
www.autodesk.com/certification

Discussion Groups: 
discussion.autodesk.com 

Find a Reseller:
www.autodesk.com/reseller

Blogs: 
www.autodesk.com/blogs 

Find an Authorized Training Center:
www.autodesk.com/atc

Communities: 
www.autodesk.com/community 

Find an Authorized Training Center Course:
www.autodesk.com/atcevents

Student Community: 
students.autodesk.com

Services & Support:
www.autodesk.com/servicesandsupport
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